
WebLogic Server
Enterprise JavaBeans

D o c u m e n t 1 . 0
A p r i l 2 0 0 0

BEA





Copyright

Copyright © 2000 BEA Systems, Inc. All Rights Reserved.

Restricted Rights Legend

This software and documentation is subject to and made available only pursuant to the terms of the BEA Systems
License Agreement and may be used or copied only in accordance with the terms of that agreement. It is against
the law to copy the software except as specifically allowed in the agreement. This document may not, in whole or
in part, be copied photocopied, reproduced, translated, or reduced to any electronic medium or machine readable
form without prior consent, in writing, from BEA Systems, Inc.

Use, duplication or disclosure by the U.S. Government is subject to restrictions set forth in the BEA Systems
License Agreement and in subparagraph (c)(1) of the Commercial Computer Software-Restricted Rights Clause
at FAR 52.227-19; subparagraph (c)(1)(ii) of the Rights in Technical Data and Computer Software clause at
DFARS 252.227-7013, subparagraph (d) of the Commercial Computer Software--Licensing clause at NASA FAR
supplement 16-52.227-86; or their equivalent.

Information in this document is subject to change without notice and does not represent a commitment on the part
of BEA Systems. THE SOFTWARE AND DOCUMENTATION ARE PROVIDED "AS IS" WITHOUT
WARRANTY OF ANY KIND INCLUDING WITHOUT LIMITATION, ANY WARRANTY OF
MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. FURTHER, BEA Systems DOES
NOT WARRANT, GUARANTEE, OR MAKE ANY REPRESENTATIONS REGARDING THE USE, OR THE
RESULTS OF THE USE, OF THE SOFTWARE OR WRITTEN MATERIAL IN TERMS OF CORRECTNESS,
ACCURACY, RELIABILITY, OR OTHERWISE.

Trademarks or Service Marks

BEA, WebLogic, jDriver, ObjectBroker, TOP END, and TUXEDO are registered trademarks of BEA Systems,
Inc. BEA Builder, BEA Connect, BEA Manager, BEA MessageQ, Jolt and M3 are trademarks of BEA Systems,
Inc.

All other company names may be trademarks of the respective companies with which they are associated.

Installing and Starting WebLogic Server 5.1

Document Edition Date Software Version

1.0 April 2000 WebLogic Server 5.1





BEA WebLogic Server Version 5.1 Enterprise JavaBeans v

1. EJB Features and Changes in WebLogic Server Version 5.1
Overview ........................................................................................................... 1-1

New Features..................................................................................................... 1-1

EJB 1.1 compliance.................................................................................... 1-1

Application assembly support in DeployerTool ........................................ 1-2

DDConverter upgrade utility ..................................................................... 1-2

Full JNDI support for EJB environment .................................................... 1-2

New resource factory support .................................................................... 1-3

Support for EJB home handles................................................................... 1-3

Improved free pool management ............................................................... 1-3

Improved manageability for multiple persistence types ............................ 1-4

WebLogic Query Language (WLQL) supports embedded Java................ 1-4

is-modified-method-name support for bean-managed EJBs...................... 1-4

New Java type support for multi-object finders......................................... 1-4

Changed behavior.............................................................................................. 1-5

EJB deployment ......................................................................................... 1-5

javax.ejb.deployment classes not used ............................................... 1-5

Default transaction properties ............................................................. 1-5

XML deployment descriptors ............................................................. 1-5

Text descriptor to XML element mapping ......................................... 1-6

Deleted deployment properties ........................................................... 1-9

.jar and directory deployment units .................................................... 1-9

Unsupported deployment utilities ..................................................... 1-10

Persistence Services ................................................................................. 1-10

File-based persistence not supported ................................................ 1-10

JDBC-based persistence renamed to RDBMS-based persistence .... 1-10

Entity EJB changes .................................................................................. 1-11

orderBy not supported in WebLogic Query Language..................... 1-11

Primary key changes for container-managed EJBs .......................... 1-11

Simple and compound primary keys ................................................ 1-11

EJB exception changes............................................................................. 1-12

New ejbc syntax ....................................................................................... 1-12

Required changes for EJB 1.1 compliance...................................................... 1-13

Updates for EJB classes and interfaces.................................................... 1-13

General EJB updates ......................................................................... 1-13



vi BEA WebLogic Server Version 5.1 Enterprise JavaBeans

Entity EJB Updates ........................................................................... 1-16

EJBs using the UserTransaction interface ........................................ 1-16

Deprecated methods from javax.ejb.EJBContext ............................. 1-16

Updates for EJB Clients ........................................................................... 1-17

Accessing EJBs ................................................................................. 1-17

Removing session beans ................................................................... 1-18

2. Upgrading EJBs to WebLogic Server Version 5.1
Overview ........................................................................................................... 2-1

Requirements..................................................................................................... 2-2

Text deployment descriptor........................................................................ 2-2

Compiled classes and interfaces................................................................. 2-2

Step 1: Convert the text deployment descriptor ................................................ 2-3

Optional conversion tasks .......................................................................... 2-5

Step 2: Package EJB Classes and Interfaces ..................................................... 2-6

Step 3: Edit deployment properties and check compliance............................... 2-8

3. The WebLogic Server EJB Container
Overview ........................................................................................................... 3-1

EJB Lifecycle in WebLogic Server ................................................................... 3-2

Stateless session EJB lifecycle ................................................................... 3-2

Initializing EJB instances.................................................................... 3-2

Activating and pooling EJBs............................................................... 3-3

Stateful EJB lifecycle ................................................................................. 3-3

Initializing and using EJB instances ................................................... 3-4

Passivating stateful EJBs .................................................................... 3-4

Removing stateful session EJB instances ........................................... 3-5

Stateful session EJB requirements ...................................................... 3-6

ejbLoad() and ejbStore() behavior for entity EJBs............................................ 3-6

Using db-is-shared to limit calls to ejbLoad()............................................ 3-7

Restrictions and warnings for db-is-shared......................................... 3-8

Using is-modified-method-name to limit calls to ejbStore() ..................... 3-8

Warning for is-modified-method-name .............................................. 3-9

Using delay-updates-until-end-of-tx to change ejbStore() behavior.......... 3-9

Setting the cache strategy for entity EJBs................................................ 3-10



BEA WebLogic Server Version 5.1 Enterprise JavaBeans vii

read-write cache strategy .................................................................. 3-10

read-only cache strategy ................................................................... 3-10

“read-mostly” pattern........................................................................ 3-11

EJBs in WebLogic Server Clusters ................................................................. 3-12

Overview.................................................................................................. 3-12

Clustered EJBHome objects ............................................................. 3-13

Clustered EJBObjects ....................................................................... 3-13

Session EJBs in a cluster.......................................................................... 3-14

Stateless session EJBs....................................................................... 3-14

Stateful session EJBs ........................................................................ 3-15

Entity EJBs in a cluster ............................................................................ 3-16

read-write entity EJBs....................................................................... 3-16

read-only entity EJBs........................................................................ 3-17

Transaction management................................................................................. 3-18

Transaction management responsibilities ................................................ 3-18

Using javax.transaction.UserTransaction ................................................ 3-19

Restriction for container-managed EJBs .......................................... 3-19

Distributing transactions across multiple EJBs........................................ 3-20

Calling multiple EJBs from a single transaction context.................. 3-20

Encapsulating a multi-operation transaction..................................... 3-21

Distributing transactions across EJBs in a WebLogic Server cluster3-21

Transaction isolation level ....................................................................... 3-21

Limitations of TRANSACTION_SERIALIZABLE ........................ 3-22

Special note for Oracle Databases .................................................... 3-22

Resource Factories .......................................................................................... 3-22

Setting up JDBC datasource factories...................................................... 3-23

Setting up URL connection factories ....................................................... 3-24

Setting up javax.mail.Session resources .................................................. 3-25

Persistence Services ........................................................................................ 3-26

Using WebLogic Server RDBMS Persistence......................................... 3-26

Writing Finders for RDBMS Persistence ......................................... 3-27

Using WebLogic Query Language (WLQL) .................................... 3-29

Using Java Expressions in WLQL.................................................... 3-32



viii BEA WebLogic Server Version 5.1 Enterprise JavaBeans

4. WebLogic Server EJB Design and Development
Overview ........................................................................................................... 4-1

Invoking deployed EJBs.................................................................................... 4-1

Local vs. remote clients.............................................................................. 4-2

Restrictions for accessing EJB instances ................................................... 4-3

Storing EJB references in home handles.................................................... 4-3

Using home handles across a firewall................................................. 4-3

EJB Design Tips ................................................................................................ 4-4

Preserve transaction resources ................................................................... 4-4

Allow the datastore to manage transactions........................................ 4-4

Use container-managed transactions over bean-managed transactions4-5

Never demarcate transactions from a client application ..................... 4-5

Use correct modeling for entity EJBs ........................................................ 4-5

Entity EJBs should be coarse-grained................................................. 4-6

Entity EJBs should contain business logic.......................................... 4-6

Optimize entity EJB data access ......................................................... 4-6

Use isModified() where appropriate ................................................... 4-7

Using inheritance with EJBs ...................................................................... 4-7

Using Session Beans .................................................................................. 4-8

5. Deploying EJBs in WebLogic Server
Overview ...............................................................................................................1

Required steps for deploying EJBs........................................................................1

Setting deployment properties........................................................................2

Generating EJB container classes ..................................................................4

Loading EJB classes into WebLogic Server ..................................................5

Overview of WebLogic Server classloading ..........................................5

Deploying EJBs at startup .....................................................................................9

Deploying EJBs in a running WebLogic Server (Hot Deployment)...................10

Hot deploy concepts and restrictions ...........................................................10

EJB deployment names.........................................................................11

Undeployment.......................................................................................11

Updating deployment units ...................................................................12

Viewing deployed EJBs ...............................................................................12

Deploying new EJBs ....................................................................................13



BEA WebLogic Server Version 5.1 Enterprise JavaBeans ix

Undeploying deployed EJBs........................................................................13

Updating deployed EJBs..............................................................................14

6. Deploying EJBs with DeployerTool
Overview ........................................................................................................... 5-1

WebLogic Server deployment files............................................................ 5-2

Roles and responsibilities........................................................................... 5-3

Deployer projects ................................................................................ 5-4

Developer projects .............................................................................. 5-4

Requirements..................................................................................................... 5-4

.jar file ........................................................................................................ 5-5

WebLogic Servers...................................................................................... 5-6

Getting started ................................................................................................... 5-6

DeployerTool basics.......................................................................................... 5-7

Menu bar .................................................................................................... 5-8

Tool bar ...................................................................................................... 5-9

Object panel ............................................................................................... 5-9

Top-level categories............................................................................ 5-9

Edit panel ................................................................................................... 5-9

Message panel .......................................................................................... 5-10

Starting DeployerTool..................................................................................... 5-11

Setting up DeployerTool servers and preferences........................................... 5-12

Editing WebLogic Server connections .................................................... 5-12

Changing DeployerTool preferences ....................................................... 5-14

Working with EJB deployment units .............................................................. 5-15

Loading a .jar file ..................................................................................... 5-15

Viewing the contents of a .jar .................................................................. 5-16

Setting .jar file display properties ............................................................ 5-17

Creating a new .jar file ............................................................................. 5-19

Configuring basic EJB properties ................................................................... 5-20

Setting EJB class properties ..................................................................... 5-20

Setting method transaction attributes ....................................................... 5-22

Assigning method permissions ................................................................ 5-24

Default method permissions in WebLogic Server ............................ 5-24

Changing method permissions.......................................................... 5-25



x BEA WebLogic Server Version 5.1 Enterprise JavaBeans

Adding, removing, and changing environment entries ............................ 5-27

Configuring WebLogic Server deployment properties ................................... 5-29

Setting cache and performance properties ............................................... 5-29

Setting clustering properties..................................................................... 5-32

Mapping EJB references.................................................................................. 5-34

Mapping application roles to WebLogic Server principals...................... 5-34

Mapping EJB references .......................................................................... 5-35

Mapping resource factory references ....................................................... 5-38

Configuring persistence properties for entity EJBs......................................... 5-40

Configuring container-managed fields..................................................... 5-40

Configuring WebLogic Server RDBMS-based persistence..................... 5-42

Specifying the table and connection for RDBMS operations ........... 5-42

Mapping container-managed fields to database columns ................. 5-44

Editing EJB finder method expressions ............................................ 5-45

Validating deployment units............................................................................ 5-47

Validating deployment properties ............................................................ 5-48

Checking for compliance with EJB 1.1.................................................... 5-49

Compiling and deploying EJBs ....................................................................... 5-50

Compiling EJB container classes ............................................................. 5-50

Deploying .jar files to WebLogic Server ................................................. 5-50

7. WebLogic Server EJB Reference
Overview ........................................................................................................... 7-1

ejbc .................................................................................................................... 7-1

Syntax......................................................................................................... 7-2

Arguments .................................................................................................. 7-2

Options ....................................................................................................... 7-2

Examples .................................................................................................... 7-3

DDConverter ..................................................................................................... 7-3

Syntax......................................................................................................... 7-4

Arguments .................................................................................................. 7-4

Options ....................................................................................................... 7-4

Examples .................................................................................................... 7-4

deploy ................................................................................................................ 7-5

Syntax......................................................................................................... 7-5



BEA WebLogic Server Version 5.1 Enterprise JavaBeans xi

Arguments .................................................................................................. 7-5

Options ....................................................................................................... 7-6

Examples .................................................................................................... 7-6

XML deployment properties ............................................................................. 7-7

Manually editing XML deployment files................................................... 7-7

Basic conventions ............................................................................... 7-7

DOCTYPE header information .......................................................... 7-7

Document Type Definitions (DTDs) for validation ........................... 7-8

weblogic-ejb-jar.xml Properties................................................................. 7-9

Caching properties ............................................................................ 7-10

Persistence properties ....................................................................... 7-12

Clustering properties......................................................................... 7-15

Transaction properties....................................................................... 7-18

EJB references .................................................................................. 7-18

Security role assignments ................................................................. 7-19

weblogic-cmp-rdbms-jar.xml Properties ................................................. 7-20

RDBMS definition elements............................................................. 7-22

EJB field-mapping elements ............................................................. 7-22

Finder elements................................................................................. 7-23

Persistence options............................................................................ 7-25

options............................................................................................... 7-25



xii BEA WebLogic Server Version 5.1 Enterprise JavaBeans



BEA WebLogic Server Version 5.1 Enterprise JavaBeans 1-1

CHAPTER

1 EJB Features and
Changes in WebLogic
Server Version 5.1

Overview

This section provides an overview of new features and changes introduced in the
WebLogic Server Version 5.1 Enterprise JavaBeans implementation.

New Features

EJB 1.1 compliance

WebLogic Server Version 5.1 is compliant with the JavaSoft EJB 1.1 specification.
The WebLogic Server EJB documentation describes key features of the EJB 1.1
specification that you need to understand in order to use WebLogic Server. However,
you should also read the JavaSoft EJB 1.1 specification to familiarize yourself with
basic EJB development practices.

See Required changes for EJB 1.1 compliance for a summary of EJB 1.1 changes that
may require updates to your EJB classes, interfaces, and client applications.

http://java.sun.com/products/ejb/index.html
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Application assembly support in DeployerTool

WebLogic Server includes the new DeployerTool utility, which provides a graphical
interface for EJB Application Assemblers. DeployerTool provides an easy way to
map new EJB 1.1 application roles, resource references, and EJB references to actual
objects available in running servers. DeployerTool also simplifies the process of
configuring multiple EJB deployment units and deploying them to one or more
WebLogic Servers.

See Deploying EJBs with DeployerTool for complete instructions on using
DeployerTool.

DDConverter upgrade utility

The new DDConverter utility provides a quick and easy way to upgrade earlier
WebLogic Server EJB deployment descriptors to WebLogic Server Version 5.1.
DDConverter takes an existing WebLogic Server text description file and generates
the ejb-jar.xml and weblogic-ejb-jar.xml files required for deploying to
Version 5.1. DDConverter also automatically generates a
weblogic-cmp-rdbms-jar.xml deployment file for entity EJBs that use WebLogic
RDBMS-based persistence services.

See Upgrading EJBs to WebLogic Server Version 5.1 for complete instructions on
using DeployerTool and upgrading earlier deployment units.

Full JNDI support for EJB environment

EJBs now access all environment properties using JNDI. To set up environment
properties using DeployerTool, see Adding, removing, and changing environment
entries. See EJB field-mapping elements for information about how environment
entries are defined in the weblogic-ejb-jar.xml deployment file.
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New resource factory support

WebLogic Server introduces several changes and additions to resource factory support
in Version 5.1:

� JDBC connection pools can now be accessed using the
javax.sql.datasource resource factory

� New resource factory support is provided for:

� URL connections

� Java mail session factories are supported

� JMS connections

See Resource Factories in The WebLogic Server EJB Container for information on
setting up JDBC, URL, and Java mail session resources.

Support for EJB home handles

WebLogic Server supports home handles for entity and session EJBs. Using home
handles, a client can store a reference to an EJB home over long periods of time,
re-creating the reference as needed, without referring to the bean’s home name in a
JNDI context. See Storing EJB references in home handles for more information.

Improved free pool management

WebLogic Server Version 5.1 contains a new deployment descriptor that provides
increased manageability for the stateless session EJB free pool. Using
initial-beans-in-free-pool, deployers can populate the free pool with EJB instances at
startup; startup classes are no longer required to create an initial pool of bean instances.
Deployers can also enforce hard limits for the number of EJB instances that reside in
the free pool by using max-beans-in-free-pool.

Also, WebLogic Server no longer uses the free pool to store instances of stateful
session EJBs. See Caching properties for more information.
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Improved manageability for multiple persistence types

In WebLogic Server Version 5.1, EJB deployers can easily set up multiple
container-managed persistence types for development or testing. The persistence type
an EJB actually uses is controlled at deployment time using the persistence-use
element. See Persistence Services for more information.

WebLogic Query Language (WLQL) supports
embedded Java

WebLogic Server provides support for embedding Java expressions within WLQL
expressions. This enables the EJB developer or EJB deployer to create advanced finder
methods for entity EJBs using container-managed persistence. See Using WebLogic
Server RDBMS Persistence for more information.

is-modified-method-name support for bean-managed
EJBs

EJB providers can now use is-modified-method-name with bean-managed entity EJBs
as well as container-managed EJBs. See Using is-modified-method-name to limit calls
to ejbStore() for more information.

New Java type support for multi-object finders

EJB providers using JDK 1.2 can now use the java.util.Collection interface to
define the collection type for finders that return multiple entity objects.
java.util.Enumeration is also supported for users of either JDK 1.1 or JDK 1.2.

See Persistence Services for more information on writing finder methods for
WebLogic Server RDBMS-based persistence.
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Changed behavior

EJB deployment

Many of the changes in the WebLogic Server Version 5.1 EJB implementation affect
EJB deployment. Both the input files and the tools used to deploy EJBs have changed.

javax.ejb.deployment classes not used

With the EJB 1.1 specification, the javax.ejb.deployment classes are not required.
WebLogic Server no longer includes the javax.ejb.deployment package.

Default transaction properties

If the EJB provider does not specify a transaction attribute in the ejb-jar.xml file,
WebLogic Server uses Supports by default. See Setting method transaction attributes
for more information.

XML deployment descriptors

Text deployment descriptions and their associated .ser files are no longer used to
deploy EJBs in WebLogic Server Version 5.1. The EJB 1.1 specification requires the
EJB provider to define common EJB properties in an XML file named ejb-jar.xml.
This XML file must conform to the DTD provided by JavaSoft in the EJB 1.1
specification.

WebLogic Server Version 5.1 introduces two XML files in addition to the
ejb-jar.xml file required by Sun:

� weblogic-ejb-jar.xml specifies deployment properties required for deploying
EJBs in WebLogic Server. For example, weblogic-ejb-jar.xml defines
timeout, pooling, and clustering behavior for EJBs.

� weblogic-cmp-rdbms-jar.xml defines properties for EJBs that use native
WebLogic RDBMS-based persistence services. Other persistence services, such
as those provided by an outside vendor such as TOPLINK, may provide

http://java.sun.com/products/ejb/index.html
http://java.sun.com/products/ejb/index.html
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different deployment files. Contact your persistence vendor for more
information.

Text descriptor to XML element mapping

Tables in this section list the deployment properties used in prior WebLogic Server
versions, and show the new XML file locations and associated XML elements that
replace those properties.

See XML deployment properties for detailed information on the WebLogic Server
XML files and their DTDs. See the JavaSoft EJB 1.1 specification for information
about the ejb-jar.xml file.

The following deployment properties are now located in the ejb-jar.xml file:

Old text property XML element in ejb-jar.xml

accessControlEntries Role names are converted to
role-name elements in the
security-role stanzas. See
Mapping application roles to
WebLogic Server principals to
define security roles using
DeployerTool.

Role assignments are converted to
equivalent elements in the
method-permission stanzas. See
Assigning method permissions for
more information.

containerManagedFields cmp-field (See Configuring
container-managed fields)

enterpriseBeanClassName ejb-class (See Setting EJB class
properties)

EntityDescriptor entity

environmentProperties env-entry (See Adding, removing,
and changing environment entries)

homeInterfaceClassName home (See Setting EJB class
properties)

http://java.sun.com/products/ejb/index.html
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The following properties are now located in weblogic-ejb-jar.xml:

isReentrant reentrant (See Setting EJB class
properties)

primaryKeyClassName prim-key-class (See Primary key
changes for container-managed
EJBs)

remoteInterfaceClassName remote (See Setting EJB class
properties)

SessionDescriptor session

stateManagementType session-type

transactionAttribute trans-attribute (See Setting
method transaction attributes)

Old text property XML element in weblogic-ejb-jar.xml

beanHomeName jndi-name

clusterProperties clustering-descriptor

dbIsShared db-is-shared

delayUpdatesUntilEndOfTx delay-updates-until-end-of-tx

homeCallRouterClassName home-call-router-class-name

homeIsClusterable home-is-clusterable

homeLoadAlgorithm home-load-algorithm

idleTimeoutSeconds idle-timeout-seconds

isModifiedMethodName is-modified-method-name

maxBeansInFreePool max-beans-in-free-pool

maxBeansInCache max-beans-in-cache

Old text property XML element in ejb-jar.xml
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Properties in the following table are now located in weblogic-cmp-rdbms-jar.xml.

Note: weblogic-cmp-rdbms-jar.xml is generated only for container-managed
entity EJBs that use WebLogic RDBMS-based persistence services

persistentStoreType persistence-type,
persistence-use

sessionTimeout trans-timeout-seconds

statelessBeanCallRouter
ClassName

stateless-bean-call-router-class-name

statelessBeanIs
Clusterable

stateless-bean-is-clusterable

statelessBeanLoad
Algorithm

stateless-bean-load-algorithm

statelessBeanMethodsAre
Idempotent

stateless-bean-methods-are-idempotent

Old text property XML element in
weblogic-cmp-rdbms-jar.xml

attributeMap attribute-map

finderDescriptors finder-list

isolationLevel transaction-isolation

poolName pool-name

tableName table-name

Old text property XML element in weblogic-ejb-jar.xml
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Deleted deployment properties

The following text deployment parameters are no longer used. When you
upgrade your existing WebLogic Server deployment file, the DDConverter
utility removes these properties:

.jar and directory deployment units

Java archive (.jar) files replace serialized deployment descriptors as the unit of
deployment for EJBs in WebLogic Server. EJB tools such as ejbc and DeployerTool
take .jar files as their input, and save modified XML deployment descriptors and
container classes in .jar files. See Upgrading EJBs to WebLogic Server Version 5.1 for
information about packaging EJB files into a .jar.

You can also deploy EJBs with the weblogic.deploy utility or
weblogic.properties file by using an EJB deployment directory. The files and
subdirectories contained in the deployment directory must observe the same
restrictions as files and subdirectories stored in a .jar file. See Deploying EJBs in
WebLogic Server for more information.

Obsolete text property Explanation

ejbObjectClassName Custom EJBhome and EJBobject implementation
classes are no longer supported.

homeClassName Custom EJBhome and EJBobject implementation
classes are no longer supported.

runAsIdentity Replaced by application role mechanisms in
ejb-jar.xmlandweblogic-ejb-jar.xml.
See Mapping application roles to WebLogic
Server principals for more information.

runAsMode Replaced by application role mechanisms in
ejb-jar.xmlandweblogic-ejb-jar.xml.
See Mapping application roles to WebLogic
Server principals for more information.
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Unsupported deployment utilities

The following EJB deployment utilities are no longer supported with WebLogic
Server Version 5.1:

� DDCreator

� EJB Deployment Wizard

The DeployerTool utility replaces the EJB Deployment Wizard as the tool for
configuring and deploying EJBs.

WebLogic Server Version 5.1 does not provide a DDCreator utility to generate new
ejb-jar.xml deployment files. However, you can use DDConverter with an earlier
WebLogic Server text deployment description to generate a valid ejb-jar.xml file.
In addition, the DeployerTool utility automatically generates the
weblogic-ejb-jar.xml and weblogic-cmp-rdbms-jar.xml files as required for
deploying to WebLogic Server Version 5.1.

Note: If you are an EJB provider and you need to create a new ejb-jar.xml file
from scratch, see the JavaSoft EJB 1.1 specification for instructions.

Persistence Services

File-based persistence not supported

WebLogic Server no longer supports file-based persistence services. If you have EJBs
that use file-based persistence services, you can re-write them to use the CloudScape
database included with WebLogic Server. CloudScape provides better performance
than the older file-based persistence services, as well as standard RDBMS
functionality.

JDBC-based persistence renamed to RDBMS-based persistence

WebLogic Server’s native persistence services (previously called JDBC-based
container-managed persistence) have been renamed to RDBMS-based persistence
services in Version 5.1. The new package name is weblogic.cmp.rdbms, and the
associated classes are packaged in
/weblogic/lib/persistence/WebLogic_RDBMS.jar.

http://java.sun.com/products/ejb/index.html
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Entity EJB changes

orderBy not supported in WebLogic Query Language

WebLogic Server Version 5.1 does not support the WLQL orderBy operator. EJB
deployers should no longer use this operator in finder methods.

Primary key changes for container-managed EJBs

With previous WebLogic Server versions, bean providers were required to wrap
primary key fields in a user-defined primary key class. This was required even for
single-field primary keys that mapped to a primitive Java object.

For example, if a primary key field existed in the underlying data store as a string
object, the bean provider still had to create a user-defined primary key class such as:

public class AccountPK implements java.io.Serializable {
public String accountId;

}

The 1.0-compliant deployment descriptor then referenced the user-defined class using:

primaryKeyClassName examples.ejb.basic.containerManaged.AccountPK

Simple and compound primary keys

With the EJB 1.1 specification, primary keys are defined as either simple or compound
keys. Simple keys use a single field in the underlying datastore as a primary key, while
compound keys use multiple fields.

For simple primary keys, the bean provider does not need to wrap the field in a
user-defined primary key class. This type of simple key is defined in the ejb-jar.xml
deployment file using only the field name and the associated Java object:

<entity>

...

<prim-key-class>java.lang.String</prim-key-class>

...

<primkey-field>accountId</primkey-field>
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...

Note: Primary keys that map to a single primitive type, such as int, still require a
primary key class wrapper. Define these primary keys as compound primary
keys.

Compound primary keys still rely on the bean provider to create a user-defined primary
key class. Compound primary keys are defined in ejb-jar.xml by specifying only the
user-defined class:

<entity>
...
<prim-key-class>
examples.ejb.basic.containerManaged.AccountPK
</prim-key-class>
...

Note: For both simple and compound primary keys, the bean provider must set up
primary key fields as container-managed fields in ejb-jar.xml.

EJB exception changes

WebLogic Server no longer rolls back a transaction when an EJB throws an application
exception. The WebLogic Server container only rolls back a transaction in response to
the EJB calling setRollbackOnly().

If an EJB throws a non-application exception, WebLogic Server rolls back the
transaction and discards the EJB instance, as required by the EJB 1.1 specification.

New ejbc syntax

The Version 5.1 ejbc utility provides changed command-line options and a new
syntax for specifying source and destination .jar files for EJB deployment units.
Furthermore, you can no longer use a serialized deployment descriptor (.ser file) as an
input to ejbc. See ejbc for a complete reference to the new ejbc syntax.

http://java.sun.com/products/ejb/index.html
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Required changes for EJB 1.1 compliance

Updates for EJB classes and interfaces

The following sections provide a summary of changes in the JavaSoft EJB 1.1
specification that may require updates to existing EJB classes and interfaces. These
changes apply to all EJBs based on the 1.0 specification, whether they were previously
deployed in WebLogic Server or in another application server.

For more information about these changes, see the EJB 1.1 specification.

Note: The ejbc compiler included with WebLogic Server Version 5.1 automatically
checks your EJB source code for compliance with many of these changes.
Review this section to address known changes before using ejbc.

General EJB updates

The EJB 1.1 specification places new requirements on EJB class declarations, and on
methods defined in the EJB’s class and remote interface. Check your classes and
interfaces to ensure that they meet the following requirements:

� All EJB classes must be declared public, and cannot be declared as final or
abstract.

� EJB classes must include a public constructor that takes no parameters.
WebLogic Server uses this constructor to create new instances of the EJB.

� EJB classes must define at least one ejbCreate() method that is declared
public, and not final or static.

The ejbCreate() method can throw a RuntimeException,
javax.ejb.EJBException, or CreateException. The EJB implementation of
ejbCreate() must not throw java.rmi.RemoteException, as this is
deprecated in the EJB 1.1 specification.

Note: Although the EJB implementation of ejbCreate() must not throw
java.rmi.RemoteException, the EJB’s home interface must declare
that create() throws this exception. In EJB 1.1, only the container or
server may throw a RemoteException.

http://java.sun.com/products/ejb/index.html
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� Business methods declared in session or entity EJBs must not be declared final

or static.

� Business methods and WebLogic Server-invoked callback methods, such as
ejbCreate() and ejbPostCreate(), should not throw
java.rmi.RemoteException. Throwing java.rmi.RemoteException from
these methods is deprecated in the EJB 1.1 specification. Business methods and
callbacks can throw either a RuntimeException or
javax.ejb.EJBException.

EJBContext.getEnvironment() Deprecated

WebLogic Server Version 5.1 no longer supports the use of getEnvironment() for
accessing EJB environment properties. All EJB clients must obtain environment
properties by accessing an environment naming context.

Note: The javac compiler displays deprecation warnings if you compile EJB code
that uses the getEnvironment() method.

When you upgrade your EJB 1.0 deployment descriptors, the DDConverter utility
places the environment entries in an EJB 1.1-compliant environment context using the
env-entry element in ejb-jar.xml. You must update your EJB code to access the
new entries.

The following excerpt shows two methods from the TraderBean example EJB that
was included with earlier versions of WebLogic Server. This EJB loads environment
properties in setSessionContext, using the getEnvironment()method. The value
of the tradeLimit property is then accessed in getTradeLimit:

...

private transient SessionContext ctx;

private transient Properties props;

...

public void setSessionContext(SessionContext ctx) {

this.ctx = ctx;

props = ctx.getEnvironment();

}

...
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private int getTradeLimit() {

return Integer.parseInt((String)props.get("tradeLimit"));

}

...

The revised version of TraderBean included with WebLogic Server Version 5.1
performs the same steps by accessing a WebLogic JNDI context. Here, the context for
the EJB is set up and the tradeLimit property is obtained in the ejbCreate method:

...

private SessionContext ctx;

private int tradeLimit;

...

public void setSessionContext(SessionContext ctx) {

log("setSessionContext called");

this.ctx = ctx;

}

...

public void ejbCreate () throws CreateException {

log("ejbCreate called");

try {

InitialContext ic = new InitialContext();

Integer tl = (Integer) ic.lookup("java:/comp/env/tradeLimit");

tradeLimit = tl.intValue();

} catch (NamingException ne) {

throw new CreateException("Failed to find environment value
"+ne);

}

}

...
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Entity EJB Updates

Check 1.0-compliant entity EJB classes and their primary key classes to ensure that
they meet the following EJB 1.1 requirements:

� Entity EJB classes must define a matching ejbPostCreate() method for each
corresponding ejbCreate() method. Like ejbCreate(), ejbPostCreate()
must be declared public, and not final or static.

ejbPostCreate() can throw a RuntimeException or
javax.ejb.EJBException, but should not throw
java.rmi.RemoteException. Throwing java.rmi.RemoteException is
deprecated in the EJB 1.1 specification.

� An entity EJB’s primary key class must implement the hashCode() and
equals(Object) methods.

� All finder methods for an entity EJB must throw FinderException.

Finder methods should not throw java.rmi.RemoteException, as this is
deprecated in the EJB 1.1 specification. Finder methods can throw a
RuntimeException or javax.ejb.EJBException in addition to the required
FinderException.

EJBs using the UserTransaction interface

The package name for javax.jts has changed to javax.transaction. If existing
EJBs use the javax.jts.UserTransaction interface, change those references to use
javax.transaction.UserTransaction.

Refer to the JavaSoft documentation on javax.transaction.UserTransaction for
additional details about the exceptions thrown in the revised interface.

The EJB 1.1 specification also restricts the use of
javax.transaction.UserTransaction to session EJBs; entity EJBs cannot use the
UserTransaction interface. Also, a session EJB cannot use both the
javax.transaction.UserTransaction and SessionSynchronization
interfaces at the same time.

Deprecated methods from javax.ejb.EJBContext

You can no longer use the getEnvironment() method from the
javax.ejb.EJBContext interface, as specified in the EJB 1.1 specification.

http://java.sun.com/products/jta/javadocs-1.0.1/javax/transaction/UserTransaction.html


Required changes for EJB 1.1 compliance

BEA WebLogic Server Version 5.1 Enterprise JavaBeans 1-17

The EJB 1.1 specification also deprecates getCallerIdentity() and
isCallerInRole(Identity). However WebLogic Server Version 5.1 still supports
these methods.

See the JavaSoft documentation for javax.ejb.EJBContext for additional information.

Updates for EJB Clients

The 1.1 EJB specification makes several changes to the way EJB clients can invoke
and remove EJBs. Use the information in the following sections to update existing EJB
clients as necessary.

For more information on these changes, see the EJB 1.1 specification. See also
Invoking deployed EJBs for general information about accessing EJBs in client code.

Accessing EJBs

Check existing EJB clients to ensure that they observe the EJB access restrictions
described in the following sections.

Casting the result of getEjbObject() in client code

The 1.1 specification requires that client code use
javax.rmi.PortableRemoteObject.narrow() to convert the result of
getEJBObject() before casting the result to the remote interface type. Using
javax.rmi.PortableRemoteObject.narrow() ensures that the code is portable
among different EJB containers.

WebLogic Server Version 5.1 supports the use of
javax.rmi.PortableRemoteObject.narrow(). However, the narrow() method
is not required except when using RMI-IIOP. When RMI-IIOP is not required, client
code can use either the narrow()method or standard Java casting conventions to cast
the result of getEJBObject().

Concurrent calls to a session EJB instance prohibited

The EJB implementation in WebLogic Server Version 5.1 enforces strict serialization
of method calls to session bean instances. Clients to session EJBs cannot make
concurrent method calls to the same instance of the bean. If more than one client
attempts to access the same method in the same bean instance, WebLogic Server
throws a java.rmi.RemoteException.

http://java.sun.com/products/ejb/javadoc-1.1/javax/ejb/EJBContext.html
http://java.sun.com/products/ejb/index.html
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Removing session beans

Check existing EJB clients ensure that they observe the following restrictions to
removing session EJBs.

ejbRemove() restriction for stateful beans

Stateful session beans cannot be removed when an instance of the EJB is participating
in a transaction. If a client attempts to remove a bean involved in a transaction,
WebLogic Server throws a java.rmi.RemoteException.

remove(primaryKey) not permitted

Prior versions of the WebLogic Server documentation indicated that session EJBs used
an “implicit” primary key. However, session beans do not have an actual primary key,
and clients cannot use javax.ejb.EJBHome.remove(primaryKey) to remove them.
Instead, use remove() to remove the current EJB instance or remove(Handle) to
remove a specific instance.
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CHAPTER

2 Upgrading EJBs to
WebLogic Server
Version 5.1

Overview

WebLogic Server Version 5.1 provides an updated implementation of the Enterprise
JavaBeans API that is compliant with JavaSoft’s EJB 1.1 specification. To use existing
EJBs with WebLogic Server Version 5.1, you must ensure that all components of your
EJB system - the EJB classes, interfaces, clients, and deployment descriptors - are
compliant with the new specification.

This section describes how to upgrade an existing EJB deployment unit to work with
WebLogic Server. The upgrade process involves the following steps, each of which is
described in the next sections:

� Step 1: Convert the text deployment descriptor. Use the DDConverter utility to
convert existing WebLogic Server EJB text deployment descriptors to EJB
1.1-compliant XML descriptors.

� Step 2: Package EJB Classes and Interfaces. Create a new .jar file containing the
EJB classes, interfaces, and XML deployment descriptor files.

� Step 3: Edit deployment properties and check compliance. Load the .jar file into
DeployerTool and adjust deployment properties as necessary.

http://java.sun.com/products/ejb/index.html
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Requirements

To convert an existing WebLogic Server EJB deployment, you must have the
following:

� the text version of an earlier WebLogic Server deployment descriptor

� the compiled EJB classes and interfaces

Note: The WebLogic Server conversion utilities cannot update deployment
description files from non-WebLogic Server application servers.

Text deployment descriptor

Obtain the WebLogic Server text deployment description of the deployment unit you
want to upgrade. The text description file must be compatible with an earlier version
of WebLogic Server. For example, you should be able to successfully create a .ser
file from the text description using tools included with your earlier WebLogic Server
version.

Note: You cannot use an existing .ser file with the DDConverter tool. Instead,
obtain the text description file that you used to generate the .ser.

Compiled classes and interfaces

Your EJB classes, home interfaces, and remote interfaces must be compiled using a
supported JDK. (See WebLogic Platform Support for more information.) Ideally, you
should also make the changes to EJB code described in Required changes for EJB 1.1
compliance before compiling.

If you did not yet update your code to observe the EJB 1.1 restrictions, you can still
begin converting the deployment unit to WebLogic Server Version 5.1. However,
DeployerTool may indicate that the code in the final .jar file is not 1.1 compliant. In
this case, you will need to fix all reported problems, recompile, and repackage the .jar
before actually deploying the EJB.

../../platforms/index.html
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Step 1: Convert the text deployment
descriptor

In WebLogic Server Version 5.1, XML deployment descriptors replace serialized
descriptors as the means of defining deployment properties. WebLogic Server
provides the DDConverter utility to generate 1.1-compliant XML files. DDConverter
takes an existing WebLogic Server text description and generates the following XML
files:

� ejb-jar.xml, which defines the basic EJB deployment properties such as the
bean class name, home and remote interfaces. This file is required as part of the
EJB 1.1 specification.

� weblogic-ejb-jar.xml, which defines WebLogic Server-specific deployment
properties such as timeout values and clustering behavior.

� weblogic-cmp-rdbms-jar.xml, which defines properties for entity EJBs that
use WebLogic Server RDBMS-based container-managed persistence services.
This file is not created for session EJBs, entity beans using bean-managed
persistence, or entity beans using third-party persistence services.

Follow these steps to upgrade an existing 1.0-compliant WebLogic Server EJB text
descriptor to the required 1.1-compliant XML files:

1. If necessary, use the instructions in Text deployment descriptor to verify that your
text deployment description is EJB 1.0-compliant.

2. Move to the directory that contains the text deployment description you want to
update. For example:

$ cd \weblogic_old\testbean1

3. Create a new directory in which to store the new XML deployment description
files:

$ mkdir converted_xml

4. Use the setEnv.cmd or setEnv.sh script to set your environment for WebLogic
Server Version 5.1:

$ cd \weblogic51

http://java.sun.com/products/ejb/index.html
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$ setenv

5. Use the WebLogic Server Version 5.1 DDConverter utility to convert the text
descriptor to EJB 1.1-compliant XML files. The syntax for DDConverter is:

$ java weblogic.ejb.utils.DDConverter -d targetDir oldDDFile

where:

� targetDir is the directory in which to store the new XML files

� oldDDFile is the name of the text deployment description to convert

For example:

$ cd \weblogic_old\testbean1

$ java weblogic.ejb.utils.DDConverter -d converted_xml
DeploymentDescriptor.txt

DDConverter updates 1.0 properties to their 1.1-equivalent properties and
creates new XML files in the specified directory. DDConverter displays
non-fatal error messages if any 1.0 properties are no longer used in WebLogic
Server Version 5.1, or if “placeholder” values are used to define required Version
5.1 properties.

6. If DDConverter displays non-fatal error messages, address those errors before
you package the new XML files into a .jar. Common error messages and their
required actions include:

Error Action

All user defined
<env-entry> items were
set to String. You will
need to manually change
the types as necessary.

Continue with Step 2: Package EJB Classes and Interfaces.
Then follow the instructions in Step 3: Edit deployment
properties and check compliance to change assigned
environment entry types to their correct Java types.

You will also need to change your EJB implementation to access
environment entries using JNDI. See
EJBContext.getEnvironment() Deprecated for more
information.
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Optional conversion tasks

When DDConverter updates the deployment descriptor for an entity bean with
container-managed persistence, it always defines a compound primary key in the
ejb-jar.xml deployment file. If your bean uses a simple primary key, consider
editing ejb-jar.xml to define a simple key. See Primary key changes for
container-managed EJBs for more information.

Also, you may want to change the default value of the jndi-name property in
ejb-jar.xml. During the upgrade process, DDConverter sets jndi-name to the
value of the beanHomeName property from your 1.0 text deployment file.

Required tag
<ejb-name> was set
arbitrarily to the JNDI
name for the bean:
bean_name. You should
manually change the
tag.

If you want to accept the default EJB name, no action is
required. To change the default name, open both the
ejb-jar.xml and weblogic-ejb-jar.xml files with a
text editor, and change the name specified in the ejb-name
property. For example:

<ejb-name>new.ejb.name</ejb-name>

Always make identical changes to the ejb-name in both
ejb-jar.xml and weblogic-ejb-jar.xml.

runAsMode is no longer
supported. Property is
not being set for
method: method_name

No action is required.

Error Action
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Step 2: Package EJB Classes and
Interfaces

The converted XML description files, along with compiled EJB classes, must be
packaged into a .jar file before compiling stubs and skeleton classes with ejbc or
loading into the WebLogic Server DeployerTool. The structure of the EJB .jar file
must observe the following requirements:

� The .jar must include a top-level directory named META-INF that contains the
XML deployment files.

� The .jar must store EJB classes and interfaces in a directory hierarchy that
matches the files’ Java package hierarchy.

The following steps explain how to create an EJB 1.1-compliant .jar file that you can
load into the WebLogic Server DeployerTool utility:

1. Create a temporary directory to use for staging the .jar file directories and files. For
example:

$ mkdir jartemp

2. Move into the temporary directory:

$ cd jartemp

3. Within the temporary directory, create a top-level META-INF directory to store the
XML deployment files:

$ mkdir META-INF

4. Create a directory hierarchy to store your EJB classes and interfaces. The
directory hierarchy must exactly match the package hierarchy of the classes and
interfaces you will include in the .jar.

For example, if you store your EJB files in the package
examples.ejb.basic.beanManaged, create the directories:

$ mkdir examples

$ mkdir examples\ejb

$ mkdir examples\ejb\basic
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$ mkdir examples\ejb\basic\beanManaged

5. Copy the compiled EJB classes and interfaces, and the 1.1-compliant XML
deployment descriptor files, into the appropriate subdirectories of the staging
directory. For example:

$ copy c:\dev\examples\ejb\basic\beanManaged\*.class
c:\jartemp\examples\ejb\basic\beanManaged

$ copy c:\dev\ejb\basic\beanManaged\converted_xml\*.xml
c:\jartemp\META-INF

6. While at the top level of the temporary directory, use the jar utility included
with your Java SDK to create the EJB jar file. For example:

$ jar cf beanManaged.jar examples\ejb\basic\beanManaged META-INF

Note: You do not need to include a MANIFEST file in the .jar file, as was required
with the EJB 1.0 specification.

7. Use the jar utility once again to verify the structure of the newly-created .jar
file. The output should indicate that:

� The .jar includes your EJB classes in directories that match your package
hierarchy, and

� The generated XML files reside in a top-level META-INF directory.

For example:

$ jar tf beanManaged.jar

META-INF/

META-INF/MANIFEST.MF

examples/ejb/basic/beanManaged/

examples/ejb/basic/beanManaged/Account.class

examples/ejb/basic/beanManaged/AccountBean.class

examples/ejb/basic/beanManaged/AccountHome.class

examples/ejb/basic/beanManaged/AccountPK.class

examples/ejb/basic/beanManaged/ProcessingErrorException.class

META-INF/ejb-jar.xml

META-INF/weblogic-ejb-jar.xml

Follow the steps in Step 3: Edit deployment properties and check compliance to load
the new .jar file into DeployerTool.
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Step 3: Edit deployment properties and
check compliance

The EJB 1.1 specification defines new deployment properties that were not part of the
text deployment description you converted in Step 1: Convert the text deployment
descriptor. Follow the steps below to load the EJB deployment unit into the WebLogic
Server DeployerTool utility and:

� set values for undefined deployment properties

� change deployment property “placeholder” values that were set by the
DDConverter utility

To open the EJB deployment .jar in DeployerTool:

1. Use the setEnv.cmd or setEnv.sh script to set your environment for WebLogic
Server Version 5.1:

$ cd \weblogic51

$ setenv

2. Start DeployerTool using the command:

% java -ms24m -mx24m weblogic.EJBDeployerTool

If you installed WebLogic Server under Windows NT, you can also start
DeployerTool using the Start menu.

3. Select the Servers category in the object panel.
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4. Click the Add button in the edit panel. DeployerTool creates a blank server
entry in the edit panel:

5. Fill in the fields of the new server entry as follows:

� Name: Enter the name to use for this WebLogic Server within
DeployerTool.

� Protocol: Select the protocol to use for connecting to the WebLogic Server

� Host: Enter the host name of the machine on which the WebLogic Server is
running.

� Listen port: Enter the WebLogic Server listen port for this server.

� System password: Enter a valid password for the server’s System account.

� Default: Click this box to have DeployerTool use this server as the default
for deployment.

6. Select File->Open...
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7. Type in the complete path to the .jar file you created in Step 2: Package EJB
Classes and Interfaces, or navigate to select the file.

8. Click Open to open the selected .jar file. DeployerTool places the new .jar file
in the deployer projects category:

9. Use the following DeployerTool links to address any non-fatal errors you
received in Step 2: Package EJB Classes and Interfaces:

� Setting EJB class properties

� Adding, removing, and changing environment entries

10. Check the .jar file for EJB 1.1 compliance using the instructions in Validating
deployment units.

11. Select File->Save to save your changes to the .jar file.

12. Deploy the .jar using the instructions in Compiling and deploying EJBs.
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CHAPTER

3 The WebLogic Server 
EJB Container

Overview

This section describes the services that are available to EJBs using the WebLogic
Server container. It includes these topics:

� EJB Lifecycle in WebLogic Server

� ejbLoad() and ejbStore() behavior for entity EJBs

� EJBs in WebLogic Server Clusters

� Transaction management

� Resource Factories

� Persistence Services

See the Overview of WebLogic Enterprise JavaBeans for a basic introduction to EJB
in WebLogic Server.

../../techoverview/ejb.html
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EJB Lifecycle in WebLogic Server

The following sections describe the lifecycle of EJB instances in WebLogic Server,
from the perspective of the server. These sections use the term EJB instance to refer to
the actual instance of the EJB class. EJB instance does not refer to the logical instance
of the EJB as seen from the point of view of a client.

Stateless session EJB lifecycle

WebLogic Server uses a free pool to improve performance and throughput for stateless
session EJBs. The free pool stores unbound stateless session EJBs. Unbound EJBs are
instances of a stateless session EJB class that are not processing a method call.

The following figure illustrates the WebLogic Server free pool, and the processes by
which stateless EJBs enter and leave the pool. Dotted lines indicate the “state” of the
EJB from the perspective of WebLogic Server.

Initializing EJB instances

By default, no EJB instances exist in WebLogic Server at startup time. As clients
access individual beans, WebLogic Server initializes new instances of the EJB class.
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You can optionally set the initial-beans-in-free-pool property in
weblogic-ejb-jar.xml to automatically create unbound EJBs in the free pool
during startup. This can improve response time when accessing EJBs, because initial
client requests can be satisfied by activating the bean from the free pool (rather than
initializing the bean and then activating it). By default,
initial-beans-in-free-pool is set to 0.

Note: The maximum size of the free pool is limited either by available memory, or
the value of the max-beans-in-free-pool deployment element.

Activating and pooling EJBs

When a client calls a method on a stateless EJB, WebLogic Server obtains an instance
from the free pool. The EJB remains active for the duration of the client’s method call.
After the method completes, the EJB is returned to the free pool. Because WebLogic
Server unbinds stateless session beans from clients after each method call, the actual
bean class instance that a client uses may be different from invocation to invocation.

If all instances of an EJB class are active and max-beans-in-free-pool has been
reached, new clients requesting the EJB class will block until an active EJB completes
a method call. If the transaction times out (or, for non-transactional calls, if five
minutes elapse), WebLogic Server throws a RemoteException.

Stateful EJB lifecycle

Note: This section describes the lifecycle of both stateful session EJBs and entity
EJBs in WebLogic Server.

WebLogic Server uses a cache of bean instances to improve the performance of
stateful EJBs. The cache stores active EJB instances in memory so that they are
immediately available for client requests. Active EJBs consist of instances that are
currently in use by a client, as well as instances that were recently in use, as described
below. The cache is unlike the free pool insofar as beans in the cache are bound either
to a particular client (as with stateful session beans) or to a primary key (as with entity
beans).
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The following figure illustrates the WebLogic Server cache, and the processes by
which stateful EJBs enter and leave the cache. Dotted lines indicate the state of the EJB
from the perspective of WebLogic Server.

Initializing and using EJB instances

No stateful EJB instances exist in WebLogic Server at startup time. (Entity EJBs
logically exist in a datastore, but they do not yet exist from the WebLogic Server
perspective.) As clients look up and obtain references to individual beans, WebLogic
Server initializes new instances of the EJB class and stores them in the cache.

While in cache, the EJBs can be quickly accessed by clients. WebLogic Server locks
a cached instance of an entity EJB only for the duration of a transaction. If the EJB is
not involved in a transaction, the instance is locked only for the duration of each
method invoke. This means that multiple clients can access the same entity EJB in a
serial fashion, but only if the bean is not involved in a transaction. See Invoking
deployed EJBs for more information about invoking EJB instances in WebLogic
Server.

Passivating stateful EJBs

To achieve high performance, WebLogic Server reserves the cache for EJBs that
clients are currently using and EJBs that were recently in use. When EJBs no longer
meet these criteria, they become eligible for passivation. Passivation is the process
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WebLogic Server uses to remove an EJB from cache while preserving the EJB’s state
on disk. While passivated, EJBs use minimal WebLogic Server resources, but they are
not immediately available for client requests (as they are while in the cache).

Note: Stateful session EJBs must abide by certain rules to ensure that bean fields can
be serialized to persistent storage. See Stateful session EJB requirements for
more information.

WebLogic Server provides the max-beans-in-cache deployment element, which
provides some control over when EJBs are passivated.

If max-beans-in-cache is reached and there are EJBs in cache that are not being
used, WebLogic Server passivates some of those beans. This occurs even if the unused
beans have not reached their idle-timeout-seconds limit (described below). If
max-beans-in-cache is reached and all EJBs in the cache are being used by clients,
WebLogic Server throws a CacheFullException.

Note: When an EJB becomes eligible for passivation, it does not mean that
WebLogic Server passivates the bean immediately. In fact, the bean may not
be passivated at all. Passivation occurs only when the EJB is eligible for
passivation and there is pressure on server resources, or when WebLogic
Server performs regular cache maintenance.

Removing stateful session EJB instances

The max-beans-in-cache and idle-timeout-seconds deployment elements also provide
some control over when stateful session EJBs are removed from the cache or from
disk:

� For cached EJB instances: When resources become scarce and there is a need
for memory in the cache, WebLogic Server examines EJB classes that are
approaching their max-beans-in-cache limit. Of those beans, WebLogic
Server takes EJB instances that have not been used for idle-timeout-seconds
and removes them from the cache (rather than passivating them to disk).
Removing, rather than passivating, the instance ensures that “inactive” EJBs do
not consume cache or disk resources in WebLogic Server.

If a stateful bean has been idle for longer than idle-timeout-seconds,
WebLogic Server may remove the instance from memory as a result of regular
cache maintenance, even if EJB’s max-beans-in-cache limit has not been
reached.
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Note: Setting idle-timeout-seconds to 0 stops WebLogic Server from removing
EJBs as part of regular cache maintenance. However, EJBs may still be
passivated if cache resources become scarce.

� For passivated EJB instances: After a stateful session EJB instance has been
passivated, a client must use the EJB instance before idle-timeout-seconds
is reached. Otherwise, WebLogic Server removes the passivated instance from
disk.

Stateful session EJB requirements

The EJB developer must ensure that a call to the ejbPassivate() method leaves a
stateful session bean in a condition where WebLogic Server can serialize its data and
passivate the bean’s instance. During passivation, WebLogic Server attempts to
serialize any fields that are not declared transient. This means that you must ensure
that all non-transient fields represent serializable objects, such as the bean’s remote
or home interface. With the EJB 1.1 specification, an EJB’s non-transient fields can
also include:

� a reference to the EJB’s JNDI environment context

� a reference to the UserTransaction object

As of the EJB 1.1 specification, references to the javax.ejb.SessionContext
object cannot be declared transient.

ejbLoad() and ejbStore() behavior for entity 
EJBs

WebLogic Server reads and writes the persistent fields of entity EJBs using calls to
ejbLoad() and ejbStore(). By default, WebLogic Server calls ejbLoad() and
ejbStore() in the following manner:

1. First, a transaction is initiated for the entity EJB. The client may explicitly initiate
a new transaction and invoke the bean, or WebLogic Server may initiate a new
transaction in accordance with the bean’s method transaction attributes.
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2. WebLogic Server calls ejbLoad() to read the most current version of the bean’s
persistent data from the underlying data store.

3. When the transaction commits, WebLogic Server calls ejbStore() to write
persistent fields back to the underlying datastore.

This simple process of calling ejbLoad() and ejbStore() ensures that new
transactions always use the latest version of the EJB’s persistent data, and always write
the data back to the data store upon committing. In certain circumstances, however,
you may want to limit calls to ejbLoad() and ejbStore() for performance reasons.
Alternately, you may want to call ejbStore() more frequently to view the
intermediate results of uncommitted transactions.

WebLogic Server provides several deployment parameters that enable you to
configure ejbLoad() and ejbStore() behavior.

Using db-is-shared to limit calls to ejbLoad()

WebLogic Server’s default behavior of calling ejbLoad() at the start of each
transaction works well for environments where multiple sources may update the
datastore. Since multiple clients (including WebLogic Server) may be modifying an
EJB’s underlying data, an initial call to ejbLoad() refreshes the bean’s cached data
and ensures that the transaction works against the most up-to-date version of the bean.

In the special circumstance where only a single WebLogic Server instance ever
accesses a particular EJB, calling ejbLoad() in this manner is unnecessary. Because
no other clients or systems update the EJB’s underlying data, the WebLogic Server’s
cached version of the EJB data is always up-to-date. Calling ejbLoad() in this special
case simply creates extra overhead for the WebLogic Server clients that access the
bean.

To avoid unnecessary calls to ejbLoad() in this special case, WebLogic Server
provides the db-is-shared deployment parameter. By default, db-is-shared is set
to “true” for each EJB, which ensures that ejbLoad() is called at the start of each
transaction. In the special case where only a single WebLogic Server instance ever
accesses an EJB’s underlying data, you can set db-is-shared to “false” in the bean’s
weblogic-ejb-jar.xml file. When you deploy an EJB with db-is-shared set to
“false,” WebLogic Server calls ejbLoad() for the bean only when:

� a client first references the EJB
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� the EJB’s transaction is rolled back

Restrictions and warnings for db-is-shared

Setting db-is-shared to “false” overrides WebLogic Server’s default ejbLoad()
behavior, regardless of whether the EJB’s underlying data is updated by one WebLogic
Server instance or multiple clients. If you incorrectly set db-is-shared to “false” and
multiple clients (database clients, other WebLogic Server instances, and so forth)
update the bean data, you run the risk of losing data integrity.

Also, due to caching limitations, you cannot set db-is-shared to “false” in a
WebLogic Server cluster.

Using is-modified-method-name to limit calls to 
ejbStore()

By default, WebLogic Server calls ejbStore() at the successful completion (commit)
of each transaction. ejbStore() is called at commit time regardless of whether or not
the EJB’s persistent fields were actually updated. WebLogic Server provides the
is-modified-method-name deployment parameter for cases where unnecessary
calls to ejbStore() may result in poor performance.

To use is-modified-method-name, EJB providers must first develop an EJB
method that “cues” WebLogic Server when persistent data has been updated. The
method must return “false” to indicate that no EJB fields were updated, or “true” to
indicate that some fields were modified.

The EJB provider or EJB deployer then identifies the name of this method using the
is-modified-method-name element in weblogic-ejb-jar.xml. WebLogic Server
calls the specified method name when a transaction commits, and calls ejbStore()
only if the method returns “true.”

Note: You can use is-modified-method-name with entity EJBs that use either
container-managed or bean-managed persistence services.
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Warning for is-modified-method-name

is-modified-method-name can improve performance by avoiding unnecessary
calls to ejbStore(). However, it places a greater burden on the EJB developer to
correctly identify when updates have occurred. If the specified
is-modified-method-name returns an incorrect flag to WebLogic Server, data
integrity problems can occur, and they may be difficult to track down.

If entity EJB updates appear to become “lost” in your system, start by ensuring that all
is-modified-method-namemethods return “true” under every circumstance. In this
way, you can revert to WebLogic Server’s default ejbStore() behavior and possibly
correct the problem.

Using delay-updates-until-end-of-tx to change ejbStore() 
behavior

By default, WebLogic Server updates the persistent store of all beans in a transaction
only at the completion (commit) of the transaction. This generally improves
performance by avoiding unnecessary updates and repeated calls to ejbStore().

If your datastore uses an isolation level of READ_UNCOMMITTED, you may want to allow
other database users to view the intermediate results of in-progress transactions. In this
case, the default WebLogic Server behavior of updating the datastore only at
transaction completion may be unacceptable.

You can disable the default behavior by using the delay-updates-until-end-of-tx
deployment element. When you set this element to “false,” WebLogic Server calls
ejbStore() after each method call, rather than at the conclusion of the transaction.

Note: Setting delay-updates-until-end-of-txt to false does not cause
database updates to be “committed” to the database after each method invoke;
they are only sent to the database. Updates are committed or rolled back in the
database only at the conclusion of the transaction.

See Setting cache and performance properties for information on changing this
deployment element using DeployerTool.
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Setting the cache strategy for entity EJBs

Entity EJBs can also use one of two cache strategies to modify basic ejbLoad() and
ejbStore() behavior:

� read-write

� read-only

You can set the cache strategy with DeployerTool by using the instructions in Setting
cache and performance properties, or by directly editing the cache-strategy element in
the weblogic-ejb-jar.xml deployment file.

read-write cache strategy

The read-write strategy defines the default caching behavior for entity EJBs in
WebLogic Server. With read-write entity EJBs, multiple clients can use the same
bean instance in transactions, and data integrity is ensured.

For read-write EJBs, WebLogic Server loads EJB data into the cache at the
beginning of each transaction, or as described in Using db-is-shared to limit calls to
ejbLoad(). WebLogic Server calls ejbStore() at the successful commit of a
transaction, or as described under Using is-modified-method-name to limit calls to
ejbStore().

read-only cache strategy

The read-only cache strategy can be used for entity EJBs that are never modified by
an EJB client, but may be updated periodically by an external source. For example, a
read-only entity EJB may be used to represent a stock quote for a particular
company, which is updated externally to the WebLogic Server system.

WebLogic Server never calls ejbStore() for a read-only entity EJB. ejbLoad() is
called initially when the EJB is created; afterwards, WebLogic Server calls ejbLoad()
only at intervals defined by the read-timeout-seconds deployment parameter.

Restrictions for read-only EJBs

Entity EJBs using the read-only cache strategy must observe the following
restrictions:
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� they cannot require updates to the EJB data, because WebLogic Server never
calls ejbStore() for read-only entity EJBs

� their transaction attributes must be set to NotSupported (the beans cannot rely
on a transaction)

� the EJB’s method calls must be idempotent, because WebLogic Server assumes
they are idempotent and will failover method calls if necessary in a cluster. See
EJBs in WebLogic Server Clusters for more information.

� because the bean’s underlying data may be updated by an external source, calls
to ejbLoad() are governed by the deployment parameter,
read-timeout-seconds

“read-mostly” pattern

WebLogic Server does not support a read-mostly cache strategy setting in
weblogic-ejb-jar.xml. However, if you have EJB data that is only occasionally
updated, you can create a “read-mostly pattern” by implementing a combination of
read-only and read-write EJBs.

In a “read-mostly” pattern, a read-only entity EJB retrieves bean data at intervals
specified by read-timeout-seconds. A separate read-write entity EJB models the
same data as the read-only EJB, and updates the data at required intervals. See the
read-mostly EJB example for more information.

When creating a read-mostly pattern, use the following suggestions to reduce the
likelihood of data consistency problems:

� for all read-only EJBs, set read-timeout-seconds to the same value for all
beans that may be updated in the same transaction

� for all read-only EJBs, set read-timeout-seconds to the smallest timeframe
that yields acceptable performance levels

� ensure that all read-write EJBs in the system update only the smallest portion
of data necessary; avoid beans that write numerous, unchanged fields to the
datastore at each ejbStore()

� ensure that all read-write EJBs update their data in a timely fashion; avoid
involving read-write beans in long-running transactions that may span the
read-timeout-seconds setting for their read-only counterparts

../../examples/ejb/extensions/readMostly/index.html
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Note that in a WebLogic Server cluster, clients of the read-only EJB benefit from
using cached EJB data. Clients of the read-write EJB benefit from true transactional
behavior, since the read-write EJB’s state always matches the state of its data in the
underlying datastore. See Entity EJBs in a cluster for more information.

EJBs in WebLogic Server Clusters

This section describes the behavior of EJBs and their associated transactions in a
WebLogic Server cluster, and explains key deployment properties that affect EJB
behavior in a cluster.

Overview

EJBs in a WebLogic Server cluster operate using modified versions of two key
structures: the Home object and the EJB Object. In a single server (unclustered)
environment, a client looks up an EJB via the EJB’s home interface, which is backed
on the server by a corresponding home object. After referencing the bean, the client
interacts with the bean’s methods via the remote interface, which is backed on the
server by an EJB object.

Home EJBHome
Interface Object

Remote EJB
Interface Object

WebLogic Server

Datastore

Client

comm
it

obtain bean

call method
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Clustered EJBHome objects

In a WebLogic Server cluster, the server-side representation of the home object can be
replaced by a cluster-aware “stub”. The cluster-aware home stub has knowledge of
EJBHome objects on all WebLogic Servers in the cluster. The clustered home stub
provides load balancing by distributing EJB lookup requests to available servers. It can
also support failover support for lookup requests, since it routes those requests to
available servers when other servers have failed.

All EJB types - stateless session, stateful session, and entity EJBs - can have
cluster-aware home stubs. Whether or not a cluster-aware home is created is
determined by the home-is-clusterable deployment property in
weblogic-ejb-jar.xml. If this property is set to “true” (the default), ejbc calls the
rmic compiler with the appropriate options to generate a cluster-aware home stub for
the EJB.

Clustered EJBObjects

In a WebLogic Server cluster, the server-side representation of the EJBObject can also
be replaced by a replica-aware EJBObject stub. This stub maintains knowledge about
all copies of the EJBObject that reside on servers in the cluster. The EJBObject stub

Datastore

Home Home
Stub

Remote Object
Stub

Server 1

Server 2

Server 3

EJBHome

EJBObject

EJBHome

EJBObject

EJBHome

EJBObject
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can provide load balancing and failover services for EJB method calls. For example, if
a client invokes an EJB method call on a particular WebLogic Server and the server
goes down, the EJBObject stub can failover the method call to another, running server.

Whether or not an EJB can utilize a replica-aware EJBObject stub depends on the type
of EJB deployed and, for entity EJBs, the cache strategy selected at deployment time.
The sections that follow describe cluster capabilities and limitations for different EJB
types.

Session EJBs in a cluster

Stateless session EJBs

Stateless session EJBs can have both a cluster-aware home stub and a replica-aware
EJBObject stub. By default, WebLogic Server provides failover services for EJB
method calls, but only if a failure occurs between method calls. For example, failover
is automatically supported if there is a failure after a method completes, or if the
method fails to connect to a server. When failures occur while an EJB method is in
progress, WebLogic Server does not automatically failover from one server to another.

This default behavior ensures that database updates within an EJB method are not
“duplicated” due to a failover scenario. For example, if a client calls a method which
increments a value in a datastore and WebLogic Server fails over to another server
before the method completes, the datastore would be updated twice for the client’s
single method call.

If methods are written in such a way that repeated calls to the same method do not
cause duplicate updates, the method is said to be “idempotent.” For idempotent
methods, WebLogic Server provides the stateless-bean-methods-are-idempotent
deployment property. If you set this property to “true” in weblogic-ejb-jar.xml,
WebLogic Server assumes that the method is idempotent and will provide failover
services for the EJB method, even if a failure occurs during a method call.
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Stateful session EJBs

Stateful session EJBs can utilize cluster-aware home stubs by setting
home-is-clusterable to “true.” This provides failover and load balancing for
stateful EJB lookups. Stateful session EJBs cannot utilize replica-aware EJBObject
stubs, and WebLogic Server does not provide failover services for method calls to
stateful session EJBs.

If you require cluster failover services for stateful objects, consider implementing the
stateful session EJB as a servlet. Servlets can maintain state through failover in a
cluster using either JDBC, an operating system file, or directly in memory. See Using
session tracking from a servlet for more information.
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Entity EJBs in a cluster

As with all EJB types, entity EJBs can utilize cluster-aware home stubs by setting
home-is-clusterable to “true.” The behavior of the EJBObject stub depends on the
cache-strategy deployment property in weblogic-ejb-jar.xml.

read-write entity EJBs

read-write entity EJBs in a cluster behave in a similar fashion to entity EJBs in a
non-clustered system, in that:

� multiple clients can use the bean in transactions

� ejbLoad() is always called at the beginning of each transaction (since the
db-is-shared deployment parameter cannot be set to “false” in a cluster)

� ejbStore() behavior is governed by the same rules described in ejbLoad() and
ejbStore() behavior for entity EJBs.
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read-write entity EJBs do not use a clustered EJBObject stub; a client’s method
calls to a particular EJB always go to a single WebLogic Server instance. If the server
that a client is using fails, the client must re-find the entity EJB using the cluster-aware
home stub.

read-write entity EJBs are not cached on individual WebLogic Server instances. As
clients of a given EJB use the bean in transactions, the WebLogic Server instance
passes the transaction to the underlying datastore. This approach preserves data
integrity for clustered entity EJBs by allowing the backing datastore to manage all
transactional locking.

Notes for non-transactional datastores

If your backing store does not support transactional locking, additional design may be
required to preserve data integrity for entity EJBs in a cluster. One approach is to
ensure that all updates to a given entity EJB take place on the same WebLogic Server
instance. This approach forces multiple clients to access the EJB in a serial fashion,
since the WebLogic Server instance locks the EJB during transactions.

To implement this solution, you would create a custom “dictionary” object to keep
track of which WebLogic Server instance is currently hosting a given entity EJB
instance. Clients to the EJB would need to lookup EJBs using the dictionary object,
rather than the EJB’s primary key class.

To support failover, the dictionary object would also need to keep track of which
WebLogic Server instances are currently available. This can be accomplished by
having each participating WebLogic Server instance populate the JNDI tree with a
unique name. The dictionary object could then poll the local JNDI tree at regular
intervals to determine whether a participating server’s JNDI “signature” was available.

read-only entity EJBs

In a clustered environment, WebLogic Server implements a fully replica-aware
EJBObject stub for read-only entity EJBs. This provides load-balancing and
failover capabilities for method calls to the beans. Because WebLogic Server assumes
read-only beans do not modify their data, it treats the bean’s methods as if they were
idempotent; if a server fails during a method call, WebLogic Server automatically
restarts the method using an available server.
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WebLogic Server calls ejbLoad() for read-only beans once when the bean is first
created. Afterwards, calls to ejbLoad() are done at regular intervals determined by
the read-timeout-seconds deployment property, to refresh the bean data.
ejbStore() is never called for read-only entity EJBs.

Transaction management

The following sections describe EJBs in several transaction scenarios. Note that in all
cases EJB transactions should be restricted to a single persistent store, because
WebLogic Server does not provide a two-phase commit protocol. EJBs that engage in
distributed transactions (transactions that make updates in multiple datastores) cannot
guarantee that all branches of the transaction commit or roll back as a logical unit.

The current version of WebLogic Server supports Java Messaging Service (JMS),
which can be used for implementing distributed transactional applications. Also,
WebLogic Enterprise supports the two-phase commit protocol.

Transaction management responsibilities

Session EJBs can rely on their own code, their client’s code, or the WebLogic Server
container to define transaction boundaries. Entity beans can use container- or
client-demarcated transaction boundaries, but they cannot define their own transaction
boundaries unless they observe certain restrictions.

If bean- or client-managed transactions are required, the managing code must use the
javax.transaction.UserTransaction interface. The EJB or client can then
access a UserTransaction object via JNDI and specify transaction boundaries with
explicit calls to tx.begin(), tx.commit(), tx.rollback(), and so forth. See
Using javax.transaction.UserTransaction for more information on defining transaction
boundaries.

For EJBs that use container-managed transactions (or EJBs that mix container and
bean-managed transactions) the EJB 1.1 specification defines several deployment
elements to control the transactional requirements for individual EJB methods. See
Setting method transaction attributes for information on changing this deployment
element using DeployerTool.
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Note: If the EJB provider does not specify a transaction attribute for a method in the
ejb-jar.xml file, WebLogic Server uses the Supports attribute by default.

Using javax.transaction.UserTransaction

To define transaction boundaries in EJB or client code, you must obtain a
UserTransaction object and begin a transaction before you obtain a JTS or JDBC
database connection. If you start a transaction after obtaining a database connection,
the connection has no relationship to the new transaction, and there are no semantics
to “enlist” the connection in a subsequent transaction context. If a JTS connection is
not associated with a transaction context, it operates similar to a standard JDBC
connection, and updates are automatically committed to the datastore.

Once you have created a database connection within a transaction context, that
connection becomes “reserved” until the transaction either commits or rolls back. To
maintain performance and throughput for your applications, always ensure that your
transaction completes quickly, so that the database connection can be released and
made available to other client requests. See Preserve transaction resources in
WebLogic Server EJB Design and Development for more information.

Note: You can associate only a single database connection with an active transaction
context.

Restriction for container-managed EJBs

For container-managed entity EJBs, you can use the
javax.transaction.UserTransaction interface or access a transactional JDBC
connection from within an EJB method. However, you must ensure that the transaction
does not access the bean’s container-managed database fields. Also note that the nested
transaction in the EJB method ultimately commits or rolls back depending on the fate
of the entity EJB transaction.
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Distributing transactions across multiple EJBs

Although WebLogic Server does not support transactions that are distributed over
multiple datasources, a single database transaction can span multiple EJBs on multiple
servers. This can be accomplished explicitly by starting a transaction and invoking
several EJBs. Or, a single EJB may invoke other EJBs that implicitly work within the
same transaction context. The following sections describe these scenarios.

Calling multiple EJBs from a single transaction context

In the following code fragment, a client application obtains a UserTransaction
object and uses it to begin and commit a transaction. The client invokes two EJBs
within the context of the transaction. The transaction attribute for each EJB has been
set to Required:

import javax.transaction.*;

...

u = (UserTransaction)
jndiContext.lookup("javax.transaction.UserTransaction");

u.begin();

account1.withdraw(100);

account2.deposit(100);

u.commit();

...

In the above code fragment, updates performed by the “account1” and “account2”
EJBs occur within the context of a single UserTransaction - they commit or roll
back as a logical unit. This is true regardless of whether “account1” and “account2”
reside on the same WebLogic Server, multiple WebLogic Servers, or a WebLogic
Server cluster.

The only requirement for wrapping EJB calls in this manner is that both “account1”
and “account2” must support the client transaction - the beans’ trans-attribute
element must be set to Required, Supports, or Mandatory.
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Encapsulating a multi-operation transaction

You can also use a “wrapper” EJB that encapsulates a transaction. The client calls the
wrapper EJB to perform an action such as a bank transfer. The wrapper EJB responds
by starting a new transaction and invoking one or more EJBs to do the work of the
transaction.

This type of transaction operates in a similar manner to the scenario described in
Calling multiple EJBs from a single transaction context. The “wrapper” EJB may
explicitly obtain a transaction context before invoking other EJBs, or WebLogic
Server may automatically create a new transaction context if the EJB’s
trans-attribute element is set to Required or RequiresNew. All EJBs invoked by
the wrapper EJB must be able to support the transaction context (their
trans-attribute elements must be set to Required, Supports, or Mandatory).

Distributing transactions across EJBs in a WebLogic Server cluster

WebLogic Server provides additional transaction performance benefits for EJBs that
reside in a WebLogic Server cluster. When a single transaction utilizes multiple EJBs,
WebLogic Server attempts to use EJB instances from a single WebLogic Server
instance, rather than using EJBs from different servers. This approach minimizes
network traffic for the transaction.

In some cases, a transaction may utilize EJBs that reside on multiple WebLogic Server
instances in a cluster. This can occur in heterogeneous clusters, where all EJBs have
not been deployed to all WebLogic Server instances. In these cases, WebLogic Server
uses a multi-tier connection to access the datastore, rather than multiple direct
connections. This approach uses fewer resources, and yields better performance for the
transaction. However, for best performance, the cluster should be homogeneous - all
EJBs should reside on all available WebLogic Server instances.

Transaction isolation level

The isolation level for transactions is set in the transaction-isolation element of the
weblogic-cmp-rdbms-jar.xml deployment file. WebLogic Server passes this value
to the underlying database. The behavior of the transaction depends both on the EJB’s
isolation level setting and the concurrency control of the underlying persistent store.
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To mirror the transaction behavior in earlier versions of WebLogic Server, set
transaction-isolation to a value that is consistent with the default isolation level for
your data store.

Limitations of TRANSACTION_SERIALIZABLE

Many datastores provide limited support for detecting serialization problems, even for
a single user connection. Therefore, even if you set transaction-isolation to
TRANSACTION_SERIALIZABLE, you may experience serialization problems due to the
limitations of the datastore. Refer to your RDBMS documentation for more details
about isolation level support.

Special note for Oracle Databases

Keep in mind that Oracle uses optimistic concurrency. As a consequence, even with a
setting of TRANSACTION_SERIALIZABLE, Oracle does not detect serialization
problems until commit time. The message returned is:

java.sql.SQLException: ORA-08177: can't serialize access for this
transaction

Even if you use the TRANSACTION_SERIALIZABLE setting for an EJB, you may receive
exceptions or rollbacks in the EJB client if contention occurs between clients for the
same rows. To avoid these problems, you must ensure that clients catch and examine
the SQL exceptions, and take appropriate action, such as restarting the transaction.

Resource Factories

In WebLogic Server Version 5.1, EJBs can access JDBC connection pools by directly
instantiating a JDBC driver. However it is recommended that you instead bind a JDBC
resource into the WebLogic Server JNDI tree as a resource factory.

Using resource factories enables the EJB deployer to map a resource factory reference
in the EJB deployment descriptor to an available resource factory in a running
WebLogic Server. Although the resource factory reference must define the type of
resource factory to use, the actual name of the resource is not specified until the bean
is deployed.
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The following sections explain how to bind JDBC, URL, and Java mail resources to
JNDI names in WebLogic Server. See Mapping resource factory references for
information on mapping JNDI names to resource factory references using
DeployerTool.

Note: WebLogic Server also supports JMS connection factories (as described in the
EJB 1.1 specification).

Setting up JDBC datasource factories

Follow these steps to bind a javax.sql.DataSource resource factory to a JNDI
name in WebLogic Server. Note that you can setup either a transactional or
non-transactional JDBC datasource as necessary:

1. Set up a JDBC connection pool in your weblogic.properties file. See Using
connection pools for more information.

2. Open your weblogic.properties file using a text editor.

3. For non-transactional JDBC datasources, add the property:

weblogic.jdbc.DataSource.jndi_name=pool_name

where jndi_name is the full WebLogic Server JNDI name to bind to the
datasource and pool_name is the name of the WebLogic Server connection pool
you created in step 1.

For example, to setup a non-transactional connection pool for demonstration
purposes, you might define the property:

weblogic.jdbc.DataSource.weblogic.jdbc.demoPool=demoPool

This binds a transactional datasource for the “demoPool” pool to the JNDI name,
“weblogic.jdbc.demoPool”.

4. For transactional JDBC datasources, add the property:

weblogic.jdbc.TXDataSource.jndi_name=pool_name

where jndi_name is the full WebLogic Server JNDI name to bind to the
transactional datasource and pool_name is the name of the WebLogic Server
connection pool you created in step 1.

For example, to setup a non-transactional connection pool for demonstration
purposes, you might define the property:

http://homepage.beasys.com/denali/classdocs/conn_pools.html
http://homepage.beasys.com/denali/classdocs/conn_pools.html
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weblogic.jdbc.TXDataSource.weblogic.jdbc.jts.demoPool=demoPool

This binds a transactional datasource for the “demoPool” pool to the JNDI name,
“weblogic.jdbc.jts.demoPool”.

5. Save the changes to weblogic.properties and reboot WebLogic Server.

6. Bind the JNDI name of the datasource to the EJB’s local JNDI environment. To
do this:

� Use the DeployerTool utility to map an existing EJB resource factory
reference to the JNDI name, as described in Mapping resource factory
references, or

� Directly edit the resource-description tag in the weblogic.ejb-jar.xml
deployment file using a text editor

Setting up URL connection factories

To setup a URL connection factory in WebLogic Server, bind a URL string to a JNDI
name using these instructions:

1. Open your weblogic.properties file using a text editor.

2. Add a weblogic.httpd.URLResource property for each URL you want to map
to a JNDI name. Use the syntax:

weblogic.httpd.URLResource.jndi_name=url_string

where jndi_name is the full WebLogic Server JNDI name to bind to the URL
factory and url_string is the URL to map. For example, the following entry
binds the specified URL to the WebLogic Server JNDI name,
“BankApp.urls.AdminServlet:”

weblogic.httpd.URLResource.BankApp.urls.AdminServlet=http://big
server.bankapp.com:7001/bankapp/admin

3. Save the changes to weblogic.properties and reboot WebLogic Server.

4. Bind the JNDI name of the connection factory to the EJB’s local JNDI
environment. To do this:

� Use the DeployerTool utility to map an existing EJB resource factory
reference to the JNDI name, as described in Mapping resource factory
references, or
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� Directly edit the resource-description tag in the weblogic.ejb-jar.xml
deployment file using a text editor

Setting up javax.mail.Session resources

EJBs in WebLogic Server can use the javax.mail.Session class to send mail over
various mail APIs. To setup a javax.mail.Session resource for use with WebLogic
Server:

1. Open your weblogic.properties file using a text editor.

2. Add a weblogic.resource.MailSession property for each
javax.mail.Session resource you want to use. The syntax is:

weblogic.httpd.MailSession.jndi_name=

mail.from=user_name,

mail.host=host_name

The jndi_name is the full WebLogic Server JNDI name to bind to the
javax.mail.Session resource. user_name specifies the mail address used for
EJBs that access the resource factory, and host_name specifies the host that
processes outgoing mail messages. For example:

weblogic.httpd.MailSession.weblogic.resource.mail.testSession=\

mail.from=joe@company_name.com, \

mail.host=smtp.company_name.com

3. Save the changes to weblogic.properties and reboot WebLogic Server.

4. Bind the JNDI name of the mail resource to the EJB’s local JNDI environment.
To do this:

� Use the DeployerTool utility to map an existing resource reference to the
JNDI name, as described in Mapping resource factory references, or

� Directly edit the resource-description tag in the weblogic.ejb-jar.xml
deployment file using a text editor
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Persistence Services

An entity EJB can save its state in any transactional or non-transactional persistent
storage (“bean-managed persistence”), or it can ask the container to save its
non-transient instance variables automatically (“container-managed persistence”).
WebLogic Server allows both choices - even a mixture of the two.

If an EJB uses container-managed persistence, the weblogic-ejb-jar.xml
deployment file specifies the type of persistence services that an EJB uses. High-level
definitions for automatic persistence services are stored in the persistence-type and
persistence-use elements. persistence-type defines one or more automatic services
that the EJB may use. persistence-use defines the actual service that the EJB uses
at deployment time.

Automatic persistence services use additional deployment files to specify their
deployment properties, and to define entity EJB finder methods. For example,
WebLogic Server RDBMS-based persistence services obtain deployment properties
and finder definitions from a particular bean using the bean’s
weblogic-cmp-rdbms-jar.xml file, described below in Using WebLogic Server
RDBMS Persistence.

Third-party persistence services may use other file formats to configure deployment
properties. However, regardless of the file type, the configuration file must be
referenced in the persistence-type and persistence-use elements in
weblogic-ejb-jar.xml.

Using WebLogic Server RDBMS Persistence

To use WebLogic Server RDBMS-based persistence, you must create a dedicated
XML deployment file and define the persistence elements for each EJB that will use
container-managed persistence. If this file is created by WebLogic Server utilities,
such as DDConverter or DeployerTool, it is named weblogic-cmp-rdbms-jar.xml.
If you create the file from scratch, you can save it to a different filename. However,
you must ensure that the persistence-type and persistence-use elements in
weblogic-ejb-jar.xml refer to the correct files.
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weblogic-cmp-rdbms-jar.xml defines the persistence properties for a single EJB
using WebLogic Server RDBMS-based persistence services. If you use multiple EJBs
with RDBMS-based persistence, you must create and reference a distinct XML file for
each bean.

Each weblogic-cmp-rdbms-jar.xml defines the following persistence properties:

� EJB connection pools

� EJB field to database element mappings

� Finder method definitions

The WebLogic Server DeployerTool provides a graphical interface for configuring
an entity EJB’s persistence properties. See Configuring persistence properties for
entity EJBs for more information.

Writing Finders for RDBMS Persistence

For EJBs that use RDBMS persistence, WebLogic Server Version 5.1 provides an easy
way to write dynamic finders. The EJB provider writes the method signature of a finder
in the EJBHome interface, and defines the finder’s query expressions in the
weblogic-cmp-rdbms-jar.xml deployment file.

ejbc creates implementations of the finder methods at deployment time, using the
expressions in weblogic-cmp-rdbms-jar.xml.

The key components of a finder for RDBMS persistence are:

� The finder method signature in EJBHome.

� A finder-list stanza in the weblogic-cmp-rdbms-jar.xml deployment file.

� A finder-query stanza defined within finder.

� An optional set of finder-expression stanzas within finder.

The following sections explain how to write EJB finders using XML elements in
WebLogic Server deployment files. You can also use the DeployerTool graphical
interface to create and edit finder methods, as described in Configuring persistence
properties for entity EJBs.
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Finder signature

EJB providers specify finder method signatures using the form findMethodName().
Finder methods defined in weblogic-cmp-rdbms-jar.xml must return a Java
collection of EJB objects.

Note: EJB providers can also define a findByPrimaryKey(primkey) method that
returns a single object of the associated EJB class. A single-object finder
method of this signature is required by the EJB 1.1 specification. If the EJB
provider does not define a findByPrimaryKey(primkey) method,
WebLogic Server creates a default implementation.

finder-list stanza

The finder-list stanza associates one or more finder method signatures in
EJBHome with the queries used to retrieve EJB objects. The following is an example
of a simple finder-list stanza using WebLogic Server RDBMS-based persistence:

<finder-list>

<finder>

<method-name>findBigAccounts</method-name>

<method-params>

<method-param>double</method-param>

</method-params>

<finder-query><![CDATA[(> balance $0)]]></finder-query>

</finder>

</finder-list>

Note: If you use a non-primitive data type in a method-param element, you must
specify a fully qualified name. For example, use java.sql.Timestamp rather
than Timestamp. If you do not use a qualified name, ejbc generates an error
message when you compile the deployment unit.
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finder-query element

finder-query defines the WebLogic Query Language (WLQL) expression used to
query EJB objects from the RDBMS. WLQL uses a standard set of operators against
finder parameters, EJB attributes, and Java language expressions. See Using
WebLogic Query Language (WLQL) for more information on WLQL.

Note: Always define the text of the finder-query value using the XML CDATA

attribute. Using CDATA ensures that any special characters in the WLQL string
do not cause errors when the finder is compiled.

finder-expression stanza

You can use the optional finder-expression to embed a Java language expression
within the WLQL expression. EJB providers can use this functionality to create
dynamic finder methods in WLQL at deployment time. See Using Java Expressions in
WLQL for more information.

Using WebLogic Query Language (WLQL)

In the weblogic-cmp-rdbms-jar.xml file, each finder-query stanza must include
a WLQL string that defines the query used to return EJBs.

Syntax

WLQL strings use the prefix notation for comparison operators:

(operator operand1 operand2)

Additional WLQL operators accept a single operand, a text string, or a keyword.

Operators

The following are valid WLQL operators:

Operator Description Sample Syntax

= Equals (= operand1 operand2)

< Less than (< operand1 operand2)

> Greater than (> operand1 operand2)
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Operands

Valid WLQL operands include:

� another WLQL expression

� a container-managed field defined elsewhere in the
weblogic-cmp-rdbms-jar.xml file

Note: You cannot use RDBMS column names as operands in WLQL. Instead,
use the EJB attribute (field) that maps to the RDBMS column, as defined
in the attribute-map in weblogic-cmp-rdbms-jar.xml.

� A finder parameter or Java expression identified by $n, where n is the number of
the parameter or expression. By default, $n maps to the nth parameter in the
signature of the finder method. To write more advanced WLQL expressions that
embed Java expressions, map $n to a Java expression as described in Using Java
Expressions in WLQL.

Note: The $n notation is based on an array that begins with 0, not 1. For example,
the first three parameters of a finder correspond to $0, $1, and $2.
Expressions need not map to individual parameters - advanced finders can
define more expressions than parameters.

<= Less than or equal to (<= operand1 operand2)

>= Greater than or equal to (>= operand1 operand2)

/ Divide (/ operand1 operand2)

! Boolean not (! operand)

& Boolean and (& operand)

| Boolean or (| operand)

like Wildcard search based on % symbol
in the supplied text_string

(like text_string%)

isNull Value of single operand is null (isNull operand)

isNotNull Value of single operand is not null (isNotNull operand)

Operator Description Sample Syntax
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Examples

The following examples show excerpts from the weblogic-cmp-rdbms-jar.xml file
that use basic WLQL expressions. You can also enter WLQL expressions using the
DeployerTool graphical interface, as described in Editing EJB finder method
expressions.

See Using Java Expressions in WLQL for more advanced examples that embed Java
expressions.

� This example returns all EJBs that have the balance attribute greater than the
balanceGreaterThan parameter specified in the finder. The finder method
signature in EJBHome is:

public Enumeration findBigAccounts(double balanceGreaterThan)

throws FinderException, RemoteException;

The sample <finder> stanza is:

<finder>

<method-name>findBigAccounts</method-name>

<method-params>

<method-param>double</method-param>

</method-params>

<finder-query>![CDATA[(> balance $0)]]</finder-query>

</finder>

Note that the balance field must be defined in the attribute map of the EJB’s
persistence deployment file.

Note: Always define the text of the finder-query value using the XML CDATA

attribute. Using CDATA ensures that any special characters in the WLQL string
do not cause errors when the finder is compiled.

� The following example shows how to use compound WLQL expressions. Also
note the use of single quotes (') to distinguish strings:

<finder-query>![CDATA[(& (> balance $0) (! (= accountType
'checking')))]]</finder-query>

� The following example finds all the EJBs in a table. It uses the sample finder
method signature:

public Enumeration findAllAccounts()
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throws FinderException, RemoteException

The sample <finder> stanza uses an empty WLQL string:

<finder>

<method-name>findAllAccounts</method-name>

<finder-query></finder-query>

</finder>

� The following query finds all EJBs whose lastName field starts with “M”:

<finder-query>![CDATA[(like lastName M%)]]</finder-query>

� This query returns all EJBs that have a null firstName field:

<finder-query>![CDATA[(isNull firstName)]]</finder-query>

Using Java Expressions in WLQL

Notes: WebLogic Server supports embedded Java statements in WLQL for writing
advanced finder capabilities. The basic WLQL functionality described in
Using WebLogic Query Language (WLQL) provides capabilities that are
necessary for most finders.

This section describes how to embed Java expressions into WLQL by editing XML
elements directly in the deployment file. You can also use the DeployerTool
graphical interface to embed Java expressions, as described in Editing EJB finder
method expressions.

In basic WLQL expressions, there is a one-to-one mapping between the parameters in
the finder method signature and the expressions designated by the $n notation. For
example, in the method signature:

public Enumeration findSomeAccounts(double maxBal, String ownerID)

throws FinderException, RemoteException

WLQL assigns $0 to the value of maxBal and $1 to the value of OwnerID by default.
Using this default mapping, you can create finders such as:

<finder>

<method-name>findSomeAccounts</method-name>
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<method-params>

<method-param>double</method-param>

<method-param>string</method-param>

</method-params>

<finder-query>![CDATA[(& (< balance $0) (= owner $1))]]</finder-query>

</finder>

WLQL also enables EJB developers to embed Java expressions within WLQL
expressions designated by $n. To use this feature, you must override the assignment of
individual $n expressions using the finder-expression stanza in
weblogic-cmp-rdbms-jar.xml.

The finder-expression stanza includes the following XML elements:

� expression-number identifies the number of the expression you want to
override. The expression number must be unique among the expressions defined
for a finder method. Expression numbers start at zero and continue in sequence
up to the total number of expressions used in the finder.

� expression-text contains the full Java expression that will replace the $n
expression number in the finder’s WLQL string. Within the expression text, you
can use the @n notation to refer to the nth parameter in the finder method
signature. Expressions need not map to individual parameters - advanced finders
can define more expressions than parameters.

Note: Always define the value of expression-text using the XML CDATA

attribute. Using CDATA ensures that the Java expression does not cause
compilation errors when the finder is compiled.

� expression-type identifies the Java return type of the Java expression. The
expression must produce a value that is compatible with the specified
expression-type. If you are unsure of the exact type of the return value,
specify an encompassing Java type (such as long when you expect that only an
int is necessary).

Note: If the generated Java expression is incompatible with the specified
expression-type, ejbc displays a error when you compile the EJB
code.
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Example

The following example uses the finder method signature:

public Enumeration findSomeAccounts(double maxBal, String ownerID)

throws FinderException, RemoteException

By embedding a simple Java expression in the WLQL string, you can convert the
supplied maxBal value to another currency before querying the RDBMS. For example,
if maxBal is supplied in U.S. dollars and the conversion rate to pounds is 1.6483, you
can use a simple expression to multiply the value:

<finder>

<method-name>findSomeAccounts</method-name>

<method-params>

<method-param>double</method-param>

<method-param>string</method-param>

</method-params>

<finder-query>(& (< balance $0) (= owner $1))</finder-query>

<finder-expression>

<expression-number>0</expression-number>

<expression-text>@0 * 1.6483</expression-text>

<expression-type>long</expression-type>

</finder-expression>

</finder>

In the above example, $0 is replaced by the Java expression @0 * 1.6483, which
multiplies the value of maxBal by 1.6483. Because the EJB provider did not override
the value of $1, WLQL maps $1 to the second parameter in the finder method
signature, ownerID.

A more advanced version of this finder could use Java to determine the conversion rate
when converting maxBal:

...

<finder-expression>
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<expression-number>0</expression-number>

<expression-text>@0 *
Double.parseDouble(System.getProperties().get(“rate.pounds.dollar
s”))</expression-text>

<expression-type>long</expression-type>

</finder-expression>

...

Restrictions

WebLogic Server does not parse or in any way validate the expression supplied in
expression-text. The EJB provider must ensure that the expression is valid Java.

Any errors in the expression text will appear as compilation errors when you compile
the EJB with ejbc.
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CHAPTER

4 WebLogic Server EJB 
Design and 
Development

Overview

This section provides a collection of design tips and debugging points to keep in mind
when building applications with Enterprise JavaBeans. A number of these tips apply
to remote object models (RMI and CORBA) as much as they do to EJB.

Invoking deployed EJBs

WebLogic Server automatically creates implementations of an EJB’s home and remote
interfaces that are remotable. This means that all clients - whether they reside in the
same server as the EJB, or on a remote computer - can access deployed EJBs in a
similar fashion.

With the EJB 1.1 specification, all EJBs must specify their environment properties
using JNDI. EJB clients can configure their JNDI name spaces to include the home
EJBs that reside anywhere on the network - on multiple machines, application servers,
or containers.
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However, in designing enterprise application systems, you must still consider the
effects of transmitting data across a network between EJBs and their clients. Due to
network overhead, it is still more efficient to access beans from a “local” client - a
servlet or another EJB - than to do so from a remote client where data must be
serialized, transmitted over the network, and then unmarshalled.

Local vs. remote clients

One difference in accessing EJBs from local versus external clients is in obtaining an
InitialContext for the bean. Remote clients obtain an InitialContext via the
WebLogic Server InitialContext factory. WebLogic Server example clients
generally use a getInitialContext method to perform this lookup, similar to the
following excerpt:

...

Context ctx = getInitialContext("http://localhost:7001", "user1",
"user1Password");

...

static Context getInitialContext(String url, String user, String password) {

Properties h = new Properties();

h.put(Context.INITIAL_CONTEXT_FACTORY,

"weblogic.jndi.WLInitialContextFactory");

h.put(Context.PROVIDER_URL, url);

h.put(Context.SECURITY_PRINCIPAL, user);

return new InitialContext(h);

}

Internal clients of an EJB, such as servlets, can simply create an InitialContext

using the default contructor, as shown here:

Context ctx = new InitialContext();
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Restrictions for accessing EJB instances

Entity EJBs can be accessed by multiple clients, but only in a serial fashion. If two
clients attempt to access the same entity EJB instance (an instance having the same
primary key), the second client blocks until the EJB is available.

An instance of a stateful session EJB can be accessed from only one client virtual
machine at a time. Multiple client threads from the same virtual machine can access
the same instance of a stateful session EJB, but they must do so in a serial fashion;
simultaneous access to a stateful session EJB results in a RemoteException, as
required by the EJB 1.1 specification.

This restriction for stateful session EJBs applies whether the EJB client is remote or
internal to WebLogic Server. If multiple servlet classes access a session EJB, each
servlet thread (rather than each instance of the servlet class) must have its own session
EJB instance. To avoid RemoteException errors in such a scenario, each servlet
should store a reference to a particular EJB instance in a local variable of the servlet’s
service() method.

Storing EJB references in home handles

Once a client has obtained the EJBHome object for an EJB instance, it can create a
reference to the home by calling getHomeHandle(). getHomeHandle() returns a
HomeHandle object, which can be used to obtain the home interface to the same EJB
instance at a later time.

A client can pass the HomeHandle object as arguments to another client, and the
receiving client can use handle to obtain a reference to the same EJBHome object.
Clients can also serialize the HomeHandle and store it in a file for later use.

Using home handles across a firewall

By default WebLogic Server stores its IP address in the HomeHandle object for EJBs.
This can cause problems with certain firewall systems. If you are unable to locate
EJBHome objects using home handles passed across a firewall, set the following
property in your weblogic.properties file:

weblogic.system.enableReverseDNSLookups=true



4 WebLogic Server EJB Design and Development

4-4 BEA WebLogic Server Version 5.1 Enterprise JavaBeans

When you enable reverse DNS lookups, WebLogic Server stores the DNS name of the
server, rather than the IP address, in EJB home handles.

EJB Design Tips

The following sections describe design tips that you should observe when developing
and deploying EJBs on your system.

Preserve transaction resources

Database transactions are typically one of the most valuable resources in an online
transaction-processing system. When using EJBs with WebLogic Server, transaction
resources are even more valuable due to their relationship with database connections.

WebLogic Server can use a single connection pool to service multiple, simultaneous
database requests. The efficiency of the connection pool is largely determined by the
number and length of database transactions that use the pool. For non-transactional
database requests, WebLogic Server can allocate and deallocate a connection very
quickly, so that the same connection can be used by another client. However, for
transactional requests, a connection becomes “reserved” by the client for the duration
of the transaction.

To optimize transaction use on your system, always follow an “inside-out” approach
to transaction demarcation - transactions should begin an end at the “inside” of the
system (the database) where possible, and move “outside” (toward the client
application) only as necessary. The following sections describe this rule in more detail.

Allow the datastore to manage transactions

Many RDBMS systems provide high-performance locking systems for OLTP
transactions. With the help of Transaction Processing (TP) monitors such as Tuxedo,
RDBMS systems can also manage complex decision support queries across multiple
datastores. If your underlying datastore has such capabilities, use them where possible.
You should never prevent the RDBMS from automatically delimiting transactions.



EJB Design Tips

BEA WebLogic Server Version 5.1 Enterprise JavaBeans 4-5

Use container-managed transactions over bean-managed transactions

Your system should rarely rely on bean-managed transaction demarcation. Use
WebLogic Server container-managed transaction demarcation unless you have a
specific need for bean-managed transactions. Possible scenarios where you may need
bean-managed transactions are:

� You must define multiple transactions from within a single method call.
WebLogic Server demarcates transactions only on a per-method basis; if you
require multiple transactions in a single method call, you must use
bean-managed transactions.

Note: If your EJBs use multiple transactions in a single method call, it is still
better to break the transactions out across multiple methods and use
container-managed transactions with the revised bean.

� A single transaction must “span” multiple EJB method calls. For example, one
method begins a transaction, and another method commits or rolls back the
transaction. In general, this practice should be avoided where possible since it
requires detailed information about the workings of the EJB object. If it is
required, you must use bean-managed transaction coordination, and you must
coordinate client calls to the respective methods.

Never demarcate transactions from a client application

In general, client applications are not guaranteed to stay active over long periods of
time. If a client begins a transaction and then exits before committing, it wastes
valuable transaction and connection resources in WebLogic Server. Moreover, even if
the client does not exit during a transaction, the duration of the transaction may be
unacceptable if it relies on user activity to commit or rollback data. Always demarcate
transactions at the WebLogic Server or RDBMS level where possible.

Use correct modeling for entity EJBs

Reading and writing RDBMS data via an entity bean can consume valuable network
resources. Network traffic may occur between a client and WebLogic Server, as well
as between WebLogic Server and the underlying datastore. Use the following
suggestions to correctly model entity EJB data and avoid unnecessary network traffic.
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Entity EJBs should be coarse-grained

You should not attempt to model every object in your system as an entity EJB. In
particular, small subsets of data consisting of only a few bytes should never exist as
entity EJBs, as the trade-off in network resources is unacceptable.

For example, line items in an invoice or cells in a spreadsheet are too fine-grained and
should not be accessed frequently over a network. In contrast, logical groupings of an
invoice’s entries, or a subset of cells in a spreadsheet may be modeled as an entity EJB,
if additional business logic is required for the data.

Entity EJBs should contain business logic

Even coarse-grained objects may be inappropriate for modelling as an entity EJB if the
data requires no additional business logic. For example, if the methods in your entity
EJB work only to set or retrieve data values, it is more appropriate use JDBC calls in
an RDBMS client or use a session EJB.

Entity EJBs should encapsulate additional business logic for the modeled data. For
example, a banking application that uses different business rules for “Platinum” and
“Gold” customers might model all customer accounts as entity EJBs; the EJB methods
can then apply the appropriate business logic when setting or retrieving data fields for
a particular customer type.

Optimize entity EJB data access

Entity EJBs ultimately model fields that exist in a data store. You should optimize
entity EJB wherever possible to simplify and minimize database access. In particular:

� Limit the complexity of joins against EJB data

� Avoid long-running operations that require disk access in the datastore

� Ensure that EJB methods return as much data as possible, so as to minimize
round-trips between the client and the datastore. For example, if your EJB client
must retrieve data fields, use bulk get/setAttributes() methods to minimize
network traffic
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Use isModified() where appropriate

Use the isModified() method in entity EJBs to eliminate unnecessary database
writes for read-only operations. See Using is-modified-method-name to limit calls to
ejbStore() for more information.

Using inheritance with EJBs

Using inheritance may be appropriate when building groups of related beans that share
common code. However, you should be aware of several inheritance restrictions that
apply to EJB implementations.

For bean-managed EJBs, the ejbCreate() method must return a primary key. Any
class that inherits from the bean-managed EJB class cannot have an ejbCreate()

method that returns a different primary key class. This restriction applies even if the
new class is derived from the base EJB’s primary key class. The restriction also applies
to the bean’s ejbFind() method.

Additional restrictions exist for EJBs where inheriting another EJB implementation
changes the interface. For example, the following table describes a situation where a
derived bean adds a new method that is meant to be accessible remotely:

Because AHome.create() and BHome.create() return different remote interfaces,
you cannot have the BHome interface inherit from the AHome interface. You can still use
inheritance to have methods in the beans that are unique to a particular class, that
inherit from a superclass or that are overridden in the subclass. See the example
Enterprise JavaBean subclass Child example packages and classes.

Bean Method Interface Method

ABean afoo() ARemote afoo()

BBean (extends ABean) bfoo() BRemote bfoo()

../../examples/ejb/subclass/index.html
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Using Session Beans 

In the Model-View-Controller pattern, the view is the GUI form and the model is the
piece of code that supplies data to the screen. In a typical client-server system, the
model lives on the same server as the view and talks to the server.

It is better to have the model reside on the server, in the form of a session bean. (This
is analogous to having a servlet providing support for an HTML form, except that a
model session bean does not affect the final presentation.) With this design there
should be one model session bean instance for each GUI form instance, which acts as
the form’s representative on the server. For example, if you have a list of 100 network
nodes to display in a form, you might have a method called getNetworkNodes() on
the corresponding EJB which returns an array of values relevant to that list.

This approach keeps the overall transaction time short, and requires minimal network
bandwidth. In contrast, consider an approach where the GUI form calls an entity EJB
finder method that retrieves references to 100 separate network nodes. For each of the
references, the client must go back to the datastore to retrieve additional data, which
consumes considerable network bandwidth and may yield unacceptable performance.
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CHAPTER

5 Deploying EJBs in 
WebLogic Server

Overview

WebLogic Server provides several utilities and methods for deploying EJB
1.1-compliant .jar files. DeployerTool provides a graphical user interface, while the
deploy utility runs from a command shell. You can even permanently deploy an EJB
by simply editing the weblogic.properties file without using a deployment utility.

The following sections provide an overview of deploying EJBs to WebLogic Server,
and explain how to deploy using the deploy utility and weblogic.properties file.
They also describe the two different ways you can deploy EJBs to WebLogic Server:
permanent deployment and hot deployment. Also refer to Deploying EJBs with
DeployerTool for complete information about using the DeployerTool utility.

Required steps for deploying EJBs

Deploying EJBs in WebLogic Server involves three distinct steps:

1. Set EJB deployment properties

2. Generate EJB container classes

3. Load EJB classes into WebLogic Server
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Setting deployment properties

The deployment process begins with a .jar file or a deployment directory that contains
the compiled EJB interfaces and implementation classes created by the EJB provider.
Regardless of whether the compiled classes are stored in a .jar file or a deployment
directory, they must reside in subdirectories that match their Java package structures.

The EJB provider should also provide an EJB 1.1-compliant ejb-jar.xml file that
describes the bundled EJB(s). ejb-jar.xml, and any other required XML deployment
files, must reside in a top-level META-INF subdirectory of the .jar or deployment
directory.

Note: The deployer does not need to include a MANIFEST file in the .jar file, as was
required with the EJB 1.0 specification. See the JavaSoft EJB 1.1 specification
for more information.

As is, the basic .jar or deployment directory cannot be deployed to WebLogic Server.
You must first create and configure WebLogic Server-specific deployment properties
in the weblogic-ejb-jar.xml file, and add that file to the deployment.
weblogic-ejb-jar.xml defines caching, clustering, and performance behavior, and
is required for all EJBs. See weblogic-ejb-jar.xml Properties for a complete list of
properties available in the file.

EJB home,
remote, bean

ejb-jar.xml

weblogic-ejb-jar.xml

weblogic-cmp-rdbms-jar1.xml

weblogic-cmp-rdbms-jar2.xml

EJB home,
remote, bean

ejb-jar.xml

Step 1:
Set deployment
properties

.jar file or deployment directory .jar file or deployment directory

http://java.sun.com/products/ejb/index.html


Required steps for deploying EJBs

BEA WebLogic Server Version 5.1 Enterprise JavaBeans 5-3

If you are deploying an entity EJB that uses container-managed persistence, you must
also include an additional deployment file for the bean’s persistence type. For
WebLogic Server RDBMS-based persistence services the file is generally named
weblogic-cmp-rdbms-jar.xml, and you require a separate file for each bean that
uses RDBMS persistence. If you use a 3rd-party persistence vendor, the file type as
well as its contents may be different; refer to your persistence vendor’s documentation
for details.

The graphical DeployerTool utility automatically generates the
weblogic-ejb-jar.xml and weblogic-cmp-rdbms-jar.xml files as necessary
when you configure the beans in a .jar file. See Deploying EJBs with DeployerTool
for more information.

You can also manually create the required XML deployment files and set deployment
properties using a text editor. XML deployment properties describes the WebLogic
Server properties and files, and provides guidelines for editing those files by hand.
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Generating EJB container classes

After you have compiled the EJB classes and added the required WebLogic Server
XML deployment files to your deployment unit, you must generate the container
classes that are used to access the bean. Container classes include both the internal
representation of the EJB that WebLogic Server uses, as well as implementation of the
external interfaces (home and remote) that clients use.

The ejbc compiler generates container classes according to the deployment properties
you have specified in WebLogic Server-specific deployment files. For example, if you
indicate that your EJBs will be used in a cluster, ejbc creates special cluster-aware
classes that will be used for deployment.

EJB home,
remote, bean

ejb-jar.xml

weblogic-ejb-jar.xml

weblogic-cmp-rdbms-jar1.xml

weblogic-cmp-rdbms-jar2.xml

Step 2:
Generate
container
classes

.jar file or deployment directory

EJB home,
remote, bean

ejb-jar.xml

weblogic-ejb-jar.xml

weblogic-cmp-rdbms-jar1.xml

weblogic-cmp-rdbms-jar2.xml

.jar file or deployment directory

ejbHomeImpl.class

ejbHomeImplWLStub.class

ejbHomeImplWLSkel.class

ejbPSWeblogic_CMP_RDBMS.class

ejbEOImpl.class



Required steps for deploying EJBs

BEA WebLogic Server Version 5.1 Enterprise JavaBeans 5-5

The DeployerTool utility automatically calls ejbc as necessary to generate container
classes for the selected .jar. See Compiling and deploying EJBs for more information.
You can also use ejbc directly from the command line by supplying the required
options and arguments. See ejbc for more information.

Loading EJB classes into WebLogic Server

The final step in deploying an EJB involves loading the generated container classes
into WebLogic Server. You can prompt WebLogic Server to automatically load EJB
classes during startup by adding an entry in weblogic.properties, as described in
Deploying EJBs at startup. Or, you can prompt a running WebLogic Server to load
EJB classes using a utility such as deploy or DeployerTool. See Deploying EJBs in
a running WebLogic Server (Hot Deployment) for more information.

Overview of WebLogic Server classloading

Note: The following discussion of classloading behavior applies only to JDK 1.2. If
you are using jview, WebLogic Server and EJB classes are loaded by a single
classloader, and you cannot use hot deployment features. See Setting the
classpath for more information.

If you are using JDK 1.1, note that JDK 1.1 does not use a top-level Java
system classloader. However, the basic description of classloading behavior
applies to both JDK 1.1 and JDK 1.2.

When you start WebLogic Server, the system begins loading Java classes using two
distinct classloaders: The system classloader and the WebLogic Server classloader.

The system classloader is the default Java classloader installed on your system (the
classloader provided by your JDK or JRE). The system classloader loads the Java
classes specified in the CLASSPATH environment variable. This includes standard Java
runtime classes, as well as the WebLogic Server boot classes located in
/weblogic/classes/boot.

One of the boot classes available in the /weblogic/classes/boot creates the
WebLogic Server classloader, which continues the startup process by loading classes
specified in the weblogic.classpath property. These classes include internal
WebLogic Server support classes as well as certain user-defined classes, such as
WebLogic Server startup classes.

../../install/startserver.html#1029223
../../install/startserver.html#1029223
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The EJB and servlet classloaders

To support hot deployment for EJBs, Servlets, and JSPs, the WebLogic Server system
must dynamically load and unload these classes in response to deployment requests.
WebLogic Server provides this support by loading each EJB .jar file and each servlet
or JSP in a separate, specialized classloader that understands how to subsequently
export and unload required classes. These specialized WebLogic Server classloaders
are the EJB classloader and the servlet classloader.

The EJB classloader loads and exports classes in an EJB 1.1-compliant .jar file. EJB
implementation classes, as well as supporting classes in the .jar file, are loaded and
maintained locally by the EJB classloader. The classloader maintains these classes
until they are subsequently redeployed, undeployed, or the server shuts down.

The EJB classloader exports an EJB’s home and remote interfaces to its parent
classloader, the WebLogic Server classloader. If the EJB’s public interfaces reference
additional supporting classes, those supporting classes are also exported. Exporting the
public interfaces and their supporting classes makes the interfaces available to other
clients in WebLogic Server that may need to access the bean (for example, other EJBs,
servlets, and JSPs). However, because they are made publicly available, the EJB’s
public interface and public interfaces cannot be subsequently redeployed, as described
in Hot deploy concepts and restrictions.

The servlet classloader provides similar support for redeploying servlets and JSPs; see
Deploying servlets from the WebLogic Console for more information on deploying
servlets and JSPs using hot deploy.

../../techdeploy/hotdeploy.html#consoledeployservlet
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Classloader hierarchy in WebLogic Server

The multiple classloaders in a WebLogic Server system reside in a hierarchy beginning
with the system classloader, which loads the WebLogic Server classloader, and so
forth. The following figure shows the hierarchical relationship between classloaders,
as well as representative classes that each classloader maintains.

An important concept to consider when deploying EJBs and servlets is that Java class
loaders, including the specialized classloaders in WebLogic Server, attempt to locate
classes using their parent class loaders, if the class is not currently available in the
classloader’s cache. Both the EJB classloader and the servlet classloader share the
same parent class loader, which can result in errors if you duplicate class names in EJB
and servlets, as described below.

Diagnosing ClassCastException errors

A common problem when deploying and using EJBs and servlets is the
ClassCastException. ClassCastExceptions can occur when a class of the same
name resides in more than one classloader within WebLogic Server. Although the
classes may have the same name and use the same bytecode, if the classes are loaded
by separate classloaders, they are treated as different classes. A common scenario is as
follows:

System Classloader

WebLogic Server boot classes
CLASSPATH classes

WebLogic Classloader

weblogic.classpath classes
Startup classes
EJB public interfaces

Servlet Classloader

Servlet classes
JSP classes

EJB Classloader

(Public Interfaces)
EJB implementation, support classes

export

EJB .jar or directory Servlet class files
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1. An EJB provider uses a support class, “Address” in an EJB’s public interface.
Upon deployment, the EJB classloader exports the EJB’s public interface, and also
exports the “Address” class, to the WebLogic classloader.

2. A servlet developer includes an identical “Address” class as part of a servlet
deployment. When the servlet class is deployed, the servlet classloader loads and
maintains an identical version of the “Address” class.

3. The servlet invokes the EJB to obtain a new object of the “Address” class. In this
case, WebLogic Server yields a ClassCastException error. Because the
“Address” class exists in both the WebLogic classloader and Servlet classloader,
they are treated as completely different classes.

To correct such ClassCastException errors, EJB and servlet developers must ensure
that no two classloaders ever load an identical class. Specifically, you should always
ensure that EJB classes reside only in the deployed EJB .jar file or EJB directory, and
that they are not included in other EJB .jar files or classpath definitions.

Diagnosing ClassNotFoundException errors

A less common problem when deploying and using EJBs is the
ClassNotFoundException. ClassNotFoundExceptions occur when a given class
cannot be loaded by a given classloader or any of its parent classloaders. Because
WebLogic Server uses a hierarchy of classloaders, diagnosing
ClassnotFoundExceptions can sometimes be difficult. The following describes a
potential class loading problem:

1. An EJB provider uses a support class, “Class1,” in an EJB implementation class.
Upon deployment, the EJB classloader loads and maintains the EJB
implementation class, which references “Class1.” “Class1” is not exported to the
WebLogic classloader, because it is not used in any of the EJB’s public interfaces.

2. A second EJB (or servlet) accesses the newly-deployed EJB, and attempts to
create an instance of class “Class1”.

3. The classloader for the second EJB (or servlet) attempts to find “Class1,” in its
local cache. If it cannot find “Class1”, the parent classloader (the WebLogic
classloader) attempts to find the class. Since “Class1” was not exported at
deployment time, the next parent classloader (the system classloader) attempts to
find the class.
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If “Class1” cannot be loaded using any of the classloaders in this hierarchy, the
client receives a ClassNotFoundException. This error occurs even though
“Class1” resides in the EJBs classloader.

To avoid class loading problems, always ensure that all support classes that must be
available to internal clients of the EJB are included in the EJB’s public interfaces, or
are themselves implemented as Java interfaces. Doing so ensures that the EJB’s
classloader exports the required classes to the WebLogic classloader, where they are
publicly available to WebLogic Server clients.

Classloading between WebLogic Servers

WebLogic Server cannot load classes “over the network” for RMI objects that reside
on a remote WebLogic Server system. If an EJB or servlet on one WebLogic Server
acts as a client to another EJB or RMI object on a second server, you must ensure that
the stub classes for the remote EJB or RMI object reside in the local server’s
CLASSPATH.

Deploying EJBs at startup

To deploy EJBs at automatically when WebLogic Server starts:

1. Follow the instructions in Setting deployment properties to ensure that your
deployable EJB .jar file or deployment directory contains the required WebLogic
Server XML deployment files.

2. Follow the instructions in Generating EJB container classes to compile
implementation classes required for WebLogic Server.

3. Use a text editor to open the weblogic.properties file for WebLogic Server to
which you will deploy the EJB.

4. Add a definition for the weblogic.ejb.deploy property in the
weblogic.properties file. The basic syntax of this property is:

weblogic.ejb.deploy=source

where source specifies the complete path and filename of the .jar to deploy, or
the complete path to the EJB deployment directory. For example:
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weblogic.ejb.deploy=C:/weblogic510/myserver/ejb_basic_beanManag
ed.jar

When you boot WebLogic Server, it automatically attempts to deploy the specified
EJB .jar file or deployment directory. You can observe the EJBs as they are loaded by
examining the WebLogic Server log file or by using the console utility.

Deploying EJBs in a running WebLogic 
Server (Hot Deployment)

Although editing the weblogic.ejb.deploy provides automatic deployment for
EJBs, it requires that you start or reboot the server before the bean can be used. Once
a bean has been deployed, another edit and reboot is required to remove the bean.

Hot deployment is provided for situations where rebooting WebLogic Server is not
feasible. Using hot deployment features, you can:

� Deploy a newly-developed EJB to a running, production system

� Remove a deployed EJB to restrict access to data

� Update a deployed EJB implementation class to fix a bug or test a new feature

Both the deploy command shell utility and the DeployerTool graphical interface use
hot deploy features for deploying and updating EJBs. Some features, such as removing
a deployed EJB, are available only by using deploy. For this reason, the following
section provides details for using the deploy at the command shell. See Deploying
EJBs with DeployerTool for information on using hot deploy with via a graphical
interface.

Hot deploy concepts and restrictions

To deploy beans into a running server, you must follow the same steps described under
Required steps for deploying EJBs. Hot deployment introduces several additional
concepts:
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� EJB deployment names

� Undeploying EJBs

� Updating EJBs

EJB deployment names

When you deploy an EJB .jar file or deployment directory using the deploy utility,
you must specify a name for the deployment unit. This name provides a shorthand
reference to the EJB deployment that you can later use to undeploy or update the EJB.

When you deploy an EJB by editing weblogic.properties, WebLogic Server
implicitly assigns a deployment name that matches the path and filename of the .jar
file or deployment directory. You can use this assigned name with deploy to undeploy
or update the bean after the server has started.

Note: The EJB deployment name remains active in WebLogic Server until the server
is rebooted. Undeploying an EJB does not remove the associated deployment
name, because you may later re-use that name to deploy the bean.

Undeployment

Undeploying an EJB effectively prohibits all clients from using the EJB. When you use
the deploy utility with the undeploy argument, the specified EJB’s implementation
class is immediately marked as unavailable in the server. WebLogic Server
automatically removes the implementation class and propagates an
UndeploymentException to all clients that were using the bean.

Undeployment does not automatically remove the specified EJB’s public interface
classes. Implementations of the home interface, remote interface, and any support
classes referenced in the public interfaces, remain in the server until all references to
those classes are released. At that point, the public classes may be removed due to
normal Java garbage collection routines.

Similarly, undeploying an EJB does not remove the deployment name associated with
the EJB .jar file or deployment directory. The deployment name remains in the server
to allow for later updates of the EJB.
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Updating deployment units

When you update the contents of an EJB .jar file or deployment directory that has been
deployed to WebLogic Server, those updates are not reflected in WebLogic Server
until:

� you reboot the server (if the .jar or directory is automatically deployed using the
weblogic.properties file), or

� you update the EJB deployment using the deploy utility

Updating an EJB deployment enables an EJB provider to make changes to a deployed
EJB’s implementation classes, recompile, and then “refresh” the implementation
classes in a running server.

When you use the deploy utility with the update argument, the currently-loaded
implementation classes for the EJB are immediately marked as unavailable in the
server, and the EJB’s classloader and associated classes are removed. WebLogic
Server automatically propagates a RedeploymentException to all clients that were
using the bean. At the same time, a new EJB classloader is created, which loads and
maintains the revised EJB implementation classes.

When clients next acquire a reference to the EJB, their EJB method calls use the
updated EJB implementation classes.

Note: You can update only the EJB implementation classes, as described in Loading
EJB classes into WebLogic Server. You cannot update the EJB’s public
interfaces, or any support classes that are used by the public interfaces. If you
make any changes to the EJB’s public classes and attempt to update the EJB,
WebLogic Server displays an incompatible class change error when a client
next uses the EJB instance.

Viewing deployed EJBs

To view EJBs that are deployed on a local WebLogic Server, use the command:

% java weblogic.deploy list password

where password is the password for the WebLogic Server System account. To list
deployed EJBs on a remote server, specify the port and host options as follows:
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% java weblogic.deploy -port port_number -host host_name
list password

Deploying new EJBs

To deploy an EJB .jar file or deployment directory that has not yet been deployed to
WebLogic Server, use the command:

% java weblogic.deploy -port port_number -host host_name
deploy password name source

where:

� name is the string you want to assign to this EJB deployment unit

� source is the full path and filename of the EJB .jar file you want to deploy, or
the full path of the EJB deployment directory

For example:

% java weblogic.deploy -port 7001 -host localhost deploy
weblogicpwd CMP_example
c:\weblogic\myserver\unjarred\containerManaged\

Undeploying deployed EJBs

To remove a deployed EJB, you need only reference the assigned deployment unit
name, as in:

% java weblogic.deploy -port 7001 -host localhost undeploy
weblogicpwd CMP_example

Note: Undeploying an EJB does not remove the EJB deployment name from
WebLogic Server. You cannot re-use the deployment name with the deploy
argument until you reboot the server. You can re-use the deployment name to
update the deployment, as described below.
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Updating deployed EJBs

To update the EJB implementation class, use the update argument and specify the
active EJB deployment name:

% java weblogic.deploy -port 7001 -host localhost update
weblogicpwd CMP_example

Note: You can update only the EJB implementation classes - not the public interfaces
or public support classes. See Updating deployment units for more
information.



BEA WebLogic Server Version 5.1 Enterprise JavaBeans 6-1

CHAPTER

6 Deploying EJBs with 
DeployerTool

Overview

The WebLogic Server DeployerTool provides a graphical interface that Application
Assemblers can use to deploy EJBs to one or more WebLogic Servers. DeployerTool
simplifies the process of configuring EJB deployment properties and mapping EJB
references to actual resource factories, roles and other EJBs available on a server.

DeployerTool provides many services related to EJB deployment. You can use it to:

� Examine all EJBs in a .jar file and change their WebLogic Server deployment
properties

� Validate EJB interfaces and classes to ensure that they are compliant with the
EJB 1.1 specification

� Map EJB references, resource references, and security roles to actual EJBs,
resource factories, and roles available in a WebLogic Server

� Generate WebLogic Server EJB implementation classes

� Deploy EJBs to one or more servers

For general information about deploying EJBs on WebLogic Server, or for information
on using hot deployment features, see Deploying EJBs in WebLogic Server.
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WebLogic Server deployment files

When you modify deployment properties with DeployerTool, the utility updates and
saves information in the XML deployment files, ensuring that the XML is correct for
its associated DTD. DeployerTool can modify certain properties in ejb-jar.xml. It
can also create the weblogic-ejb-jar.xml and weblogic-cmp-rdbms-jar.xml

files if they are not available in the .jar.

weblogic-ejb-jar.xml contains properties that define the caching, clustering, and
performance behavior of EJBs. It also contains properties that map available
WebLogic Server resources to EJBs. WebLogic Server resources include security role
names, data sources such as JDBC pools and JMS connection factories, other deployed
EJBs, and container-managed persistence services available in the server.
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Properties in weblogic-ejb-jar.xml are linked to EJB names in ejb-jar.xml,
resource names in a running WebLogic Server, and to persistence type data defined in
weblogic-cmp-rdbms-jar.xml (for entity EJBs using RDBMS persistence). This
figure shows the relationship among these components:

See XML deployment properties if you want to edit the XML deployment files
manually, outside of the DeployerTool utility.

Roles and responsibilities

DeployerTool is designed primarily for:

� Deployers who are configuring EJBs to run in the WebLogic Server container

<security-role-assignment>. . .
<weblogic-enterprise-bean>

<ejb-name>. . .
<caching-descriptor>. . .
<clustering-descriptor>. . .
<resource-descriptor>. . .
<reference-descriptor>. . .
<persistence-descriptor>. . .

</ejb-name>
</weblogic-enterprise-bean>

weblogic-ejb-jar.xml

Principal

JDBC Pool

JMS

<weblogic-rdbms-bean>
. . .

</weblogic-rdbms-bean>

weblogic-cmp-rdbms-jar.xml

<assembly-descriptor>
<security-role>. . .

</assembly-descriptor>
<entity>

<ejb-name>. . .
<ejb-ref>. . .

</entity>

ejb-jar.xml
WebLogic Server

EJB
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� Application Assemblers who are linking multiple EJBs and EJB resources to
create larger web application systems

� EJB developers who are creating and configuring new EJB .jar files

To satisfy the requirements of these roles, DeployerTool provides complete controls
for managing multiple EJB .jar files and WebLogic Servers, and for configuring
WebLogic Server deployment properties and resources. Roles are designated by two
primary types of DeployerTool projects: deployer projects and developer projects.

Deployer projects

Deployer projects enable EJB deployers and application assemblers to configure EJB
deployment properties and deploy EJB .jar files to WebLogic Server. Using deployer,
you can automatically create the required weblogic-ejb-jar.xml file with valid
deployment properties, and you can attach EJB and resource factory references to
actual resources in a running server. Deployer projects enable you to work with EJB
.jar files without knowing the details of the EJB code.

If you open a .jar file and find that you cannot edit all of the deployment parameters
you want to, try opening the file as a developer project.

Developer projects

Developer projects provide all the capabilities of a deployer project. Developer
projects also enable you to modify EJB deployment properties that may require some
knowledge of the EJB implementation code.

Note: Although a developer project enables you to configure some basic properties
defined in the ejb-jar.xml deployment file, it is the responsibility of the
Bean Provider to create this file and package it with the compiled EJB classes
and interfaces. WebLogic Server provides the DDConverter utility to
generate an ejb-jar.xml file from an existing WebLogic Server-compatible
text descriptor. See Upgrading EJBs to WebLogic Server Version 5.1 for more
information.
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Requirements

To use DeployerTool, you must have:

� a .jar file containing the EJB deployment unit

� one or more running WebLogic Servers

.jar file

An EJB deployment unit in DeployerTool consists of a Java archive (.jar) file. The
.jar file must contain all of the compiled classes for your EJB home interface, remote
interface, and implementation class. It must also have a META-INF subdirectory that
contains, at minimum, a valid ejb-jar.xml deployment file. The .jar file may contain
classes and deployment descriptors for one or more distinct EJBs.

Note: You do not need to include a MANIFEST file in the .jar file, as was required
with the EJB 1.0 specification. See the JavaSoft EJB 1.1 specification for more
information.

Optionally, the .jar file can contain the weblogic-ejb-jar.xml and
weblogic-cmp-rdbms-jar.xml files, which define deployment properties for
WebLogic Server and WebLogic RDBMS-based persistence services. If the .jar does
not contain these files, DeployerTool creates them as necessary during the
deployment process.

The following shows the contents of a simple .jar file that can be loaded into
DeployerTool:

$ jar tf ejb_basic_beanManaged.jar

META-INF/

META-INF/MANIFEST.MF

examples/ejb/basic/beanManaged/

examples/ejb/basic/beanManaged/Account.class

examples/ejb/basic/beanManaged/AccountBean.class

http://java.sun.com/products/ejb/index.html
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examples/ejb/basic/beanManaged/AccountHome.class

examples/ejb/basic/beanManaged/AccountPK.class

examples/ejb/basic/beanManaged/ProcessingErrorException.class

META-INF/ejb-jar.xml

META-INF/weblogic-ejb-jar.xml

Note: Classes in the .jar file must reside in directories that match their Java package
hierarchy. See Step 2: Package EJB Classes and Interfaces in Upgrading EJBs
to WebLogic Server Version 5.1 for more information.

WebLogic Servers

DeployerTool connects to one or more servers during the deployment process,
enabling you to map references in the deployment description files to actual WebLogic
Server resources.

For each WebLogic Server you want to use, make sure you have:

� the host name of the machine running the server

� the WebLogic Server listen port number

� a valid system password for the server

Getting started

To begin using DeployerTool:

1. Read DeployerTool basics to learn how to work with the DeployerTool user
interface.

2. Start DeployerTool using the instructions in Starting DeployerTool

3. Set up a new WebLogic Server profile using the instructions in Setting up
DeployerTool servers and preferences.



DeployerTool basics

BEA WebLogic Server Version 5.1 Enterprise JavaBeans 6-7

4. Load the .jar file you want to deploy using the instructions in Working with EJB
deployment units.

5. Read additional sections as necessary for:

� Configuring WebLogic Server deployment properties

� Mapping EJB references

� Validating deployment units

6. Deploy the .jar file to WebLogic Server using the instructions in Compiling and
deploying EJBs.

DeployerTool basics

The DeployerTool program window is divided into the following main components:

� Menu bar

� Tool bar

� Object panel

� Edit panel

� Message panel
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The figure below illustrates these components:

Menu bar

The menu bar contains several menus for:

� opening, creating, and saving .jar files

� editing DeployerTool preferences and deploying EJBs

� getting help for DeployerTool

Object
Panel

Menu bar Icon bar

Message
Edit PanelPanel
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Tool bar

Icons in the tool bar provide quick access to selected DeployerTool menu options.
Hold your cursor over an individual icon to learn its function.

Object panel

The object panel provides a hierarchical view of the .jar files, EJBs, and EJB properties
you have opened. Clicking the + symbol next to an object expands the object, listing
the nested objects or properties it contains. Clicking the - symbol collapses the object,
hiding its nested properties.

Clicking directly on an object or property name displays its details and editable fields
in the edit panel, described below.

Top-level categories

The top-level categories in the object panel represent DeployerTool Projects and
Servers. DeployerToolProjects can contain Deployer projects or Developer projects.
Developer projects allow you to configure properties that require some knowledge of
the EJB code. Deployer projects allow EJB deployers or application assemblers to
deploy EJBs on WebLogic Server without knowing the details of the EJB code.

The Servers category lists all WebLogic Servers to which DeployerTool can connect
and deploy. See Setting up DeployerTool servers and preferences for information on
configuring servers.

Edit panel

The edit panel displays detailed information about the selected .jar, EJB, or EJB
property, and allows you to edit certain property fields. The contents of the edit panel
differs depending on the object or property you have selected in the object panel. For
example, if you click on a .jar file name in the object panel, the edit panel shows
display characteristics for the .jar file. If you expand the .jar file and select the Security
object, the edit panel displays the file’s application role definitions.
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Many, but not all, of the fields displayed in the edit panel can be modified. To modify
the contents of a field, you can either:

� click on the field and type in a new value,

� click on the field and select an appropriate value from a drop-down list, or

� double-click on the field to bring up a dialog box with editable fields

The sections that follow provide details about how to edit fields to perform EJB
configuration tasks.

Message panel

The message panel displays informational and error messages as you perform tasks in
DeployerTool. The message panel has three separate displays, indicated by the tabs
at the bottom of the panel: Messages, Problems, and Console.

The Messages display (active by default) shows current progress and error messages
for the task you are performing. For example, when you check EJB classes for
compliance with the EJB1.1 specification, DeployerTool displays any
non-compliance messages in the Messages display.

The Problems display lists deployment errors for the object you have selected in the
object panel. If you select a .jar file in the Object panel, the Problems display lists all
errors associated with deployment properties in the .jar. If you select a single EJB in
the object panel, only the errors for that bean are displayed.

Deployment property errors can occur because of undefined or incorrectly defined
deployment values. The text of each error message indicates the field to enter or
modify in order to correct the error. See Validating deployment properties for more
information about addressing deployment errors.

The Console display lists any DeployerTool or Java errors that would normally
appear in the command shell you used to start DeployerTool.
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Starting DeployerTool

To start DeployerTool, first use the setEnv.cmd or setEnv.sh script to set your
environment for WebLogic Server Version 5.1:

% setenv

Use the following command to start DeployerTool:

% java -ms24m -mx24m weblogic.EJBDeployerTool

If you installed WebLogic Server under Windows NT, you can also start
DeployerTool using the Start menu.

DeployerTool loads and displays an empty program window:
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Setting up DeployerTool servers and 
preferences

DeployerTool enables you to connect and deploy to one or more WebLogic Server
products. DeployerTool manages multiple servers in the Servers category of the
object panel; each server entry defines the connection properties for a particular
WebLogic Server. You must configure at least one new server to begin deploying
EJBs.

You can optionally configure DeployerTool and ejbc options to customize the
behavior and appearance of the utility, as described in Changing DeployerTool
preferences.

Editing WebLogic Server connections

To create, modify, or delete a DeployerTool Server entry:

1. Start DeployerTool using the instructions in Starting DeployerTool.

2. Select the Servers category in the object panel.
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3. Click the Add button in the edit panel. DeployerTool creates a blank server
entry in the edit panel:

4. Fill in the fields of the new server entry as follows:

� Name: Enter the name to use for this WebLogic Server within
DeployerTool.

� Protocol: Select the protocol to use for connecting to the WebLogic Server

� Host: Enter the host name of the machine on which the WebLogic Server is
running.

� Listen port: Enter the WebLogic Server listen port for this server.

� System password: Enter a valid password for the server’s System account.

� Default: Select this box to have DeployerTool use this server as the default
for deployment.
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5. To modify an existing server profile, expand the Server category in the object
panel, and click on the name of the server entry to modify. Then edit the server
entry fields as necessary.

6. To delete an existing server profile, expand the Server category in the object
panel and click the name of the server entry to delete. Click the Remove button.

Changing DeployerTool preferences

You can modify DeployerTool preferences to specify the Java compiler that ejbc
uses during compilation. DeployerTool preferences also affect the location of
temporary files and the window size and location for the utility.

To change DeployerTool preferences:

1. Start DeployerTool using the instructions in Starting DeployerTool.

2. Select Tools->Preferences... to display the WebLogic EJB Deployer Properties
dialog:

3. To change DeployerTool environment preferences, click on the environment
category and edit the properties as follows:

� saveWindowLocations: Select true to maintain the same size and position of
DeployerTool windows through multiple sessions. saveWindowLocations
also determines whether DeployerTool re-loads the current .jar files the
next time it starts.

� tmpdir: Enter the directory in which DeployerTool stores temporary files,
or click Choose... to select the directory.

� home: Enter the home directory in which DeployerTool stores preference
information or click Choose... to select the directory. This directory is also
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the initial directory that DeployerTool looks in when you open a new .jar
file.

4. To change ejbc compiler options, click on the ejbc category and edit the
properties as follows:

� compiler: Enter the full path of the Java compiler to use with ejbc, or click
Choose... to select a compiler. By default, ejbc uses javac as a compiler.
For faster performance, specify a different compiler, such as Symantec's sj.

� keepgenerated: Select true to save the intermediate Java files that ejbc
creates during compilation, or false to discard them.

5. Click OK to save the current options.

Working with EJB deployment units

This section provides basic instructions for:

� loading an EJB deployment unit into DeployerTool

� using DeployerTool controls to:

� view and change .jar file properties

� view and change EJB properties

Loading a .jar file

DeployerTool can import multiple EJB .jar files for editing or deploying to servers.

Note: Before importing a .jar file, make sure the file meets the requirements
described in .jar file.

To load a .jar deployment unit:

1. Start DeployerTool using the instructions in Starting DeployerTool.

2. Select File->Open...
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3. Type in the complete path to the .jar file you want to import, or navigate to select
the file.

4. Click Open to open the selected .jar file. DeployerTool places the new .jar file
in the Deployer category:

Viewing the contents of a .jar

Once you have loaded a .jar file, follow these steps to view the file’s contents:

1. Expand the .jar file contents by clicking the + sign next to its filename in the object
panel.
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2. Select the Files item to display details about the class files the .jar contains:

Columns in the Files display show the name, date modified, size, and relative
directory of class files and XML deployment files contained in the .jar. You
cannot edit the information stored in these columns.

Setting .jar file display properties

Once you have loaded a .jar file, follow these steps to edit the file’s display name or
description within DeployerTool:
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1. Select the name of the .jar file in the object panel to display basic file properties:

2. Edit fields in the edit panel as necessary:

� Source JAR file: This field lists the full path and filename of the .jar file. You
cannot modify this entry.

� Display name: Enter the name DeployerTool uses to represent this .jar in
the object panel.

� Small icon file: If your .jar file contains icon files, use the drop-down list to
select the small icon file to use for display within DeployerTool.

� Large icon file: If your .jar file contains icon files, use the drop-down list to
select the large icon file to use for display within DeployerTool.

� Client JAR file: Enter the name of a client .jar file.

� Description: Enter text to describe the contents of this .jar file.
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Creating a new .jar file

DeployerTool can help you create a new EJB .jar file from scratch, if you have not
yet created one using the jar tool included in your JDK. To create a new .jar file from
scratch:

1. Select File->New... to open the New Jar File dialog:

2. Type in the full path and filename of the new .jar file to create, or use the Select
path... button to navigate to an existing location.

3. Click Finish when you have specified the new .jar file. DeployerTool adds an
entry for the new .jar file to the Developer category.

4. Select the name of the new .jar file in the object panel.

5. Select Project->Edit file set... to begin adding files to the .jar. DeployerTool
displays the Add or remove project files dialog:
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6. Click the Add files... button to select the class files and XML deployment files to
add. Navigate to the individual directories or files you want to add, and click OK.

Note: If you select a directory, DeployerTool adds all subdirectories and files
the directory contains. This helps to preserve the package structure of EJB
class files within the new .jar.

7. Return to step 6 and continue adding files to the .jar as necessary. Click OK when
you are finished.

8. The contents of the new .jar file must observe the requirements described in .jar
file. If you need to modify any of the basic EJB properties, follow the steps
below in Setting EJB class properties.

Configuring basic EJB properties

The following sections explain how to change basic EJB class and method properties.
The deployment properties described in this section are all part of the ejb-jar.xml
file defined in the JavaSoft EJB 1.1 specification.

Setting EJB class properties

Follow these steps to view or change the basic home, remote, and EJB class
information in an EJB deployment unit:

1. Start DeployerTool and load the EJB .jar file if you have not already done so.
SeeStarting DeployerTool and Loading a .jar file if you need instructions.

2. Select the + sign next to the .jar file name to display its contents.

3. Select the + sign next to the Beans object to display available EJBs in the .jar
file.

4. Select the name of the EJB you want to view or modify. DeployerTool shows
the EJB display name and icon files (if applicable) in the edit panel.

http://java.sun.com/products/ejb/index.html
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5. Select the Classes tab in the edit panel to display basic EJB class information:

6. To edit basic EJB class information, click the desired field in the edit panel and
type the new value. Editable values include:

� Bean class: Enter the class name of the EJB implementation class.

� Home interface class: Enter the class name of the EJB’s home interface class.

� Remote interface class: Enter the class name of the EJB’s remote interface
class.

Note: Classes and interfaces in the .jar file must reside in directories that match their
Java package hierarchy. See Step 2: Package EJB Classes and Interfaces in
Upgrading EJBs to WebLogic Server Version 5.1 for more information.

� Home JNDI name: Enter the JNDI name that clients will use to look up the
EJB’s home interface.
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� Maintains conversational state: (Session EJBs only) Check this box to
designate a stateful session bean, or leave the box unchecked for stateless
session beans.

� Manages its own transactions: (Session EJBs only) Check this box if the
EJB uses bean-managed transactions. Un-check the box to have WebLogic
Server manage the bean’s transactions.

� Supports reentrant transactions: Check this box to specify a reentrant EJB.
This corresponds to the reentrant element in the ejb-jar.xml file, as
described in the EJB 1.1 specification.

� Uses bean-managed persistence: Check this box if the entity EJB manages
its own persistent storage. Leave the box unchecked if you want to use
WebLogic RDBMS-based persistence services or a third-party persistence
type.

7. Select File->Save to save your changes to the .jar file.

Setting method transaction attributes

Follow these steps to create or change the transaction attributes for EJB methods:

1. Start DeployerTool and load the EJB .jar file if you have not already done so.
SeeStarting DeployerTool and Loading a .jar file if you need instructions.

2. Select the + sign next to the .jar file name to display its contents.

3. Select the .jar file’s Method transactions object. If you have already assigned
method transaction attributes for the EJB, each collection of attributes is listed as
“tx-n” where n is the collection number.

If no method transactions are available, click the Add button to create a new
“tx-0” transaction attribute. DeployerTool highlights the new attribute
collection in red to indicate that you have not yet assigned attributes to methods.

4. Select the + sign next to the Method transactions object to display available
transactions.
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5. Select the transaction attribute name that you want to view or edit.
DeployerTool displays the transaction attribute assignments in the edit panel:

6. Choose the transaction attribute you want to apply by selecting it from the
Transaction attribute drop-down menu. Valid attributes are:

� Mandatory: The caller must start a transaction before invoking the method.

� Supports: If the EJB client has an active transaction context, WebLogic
Server executes the method within the same transaction. If the client does not
have a transaction context, WebLogic Server does not create one for
invoking the method.

Note: If the EJB provider does not specify a transaction attribute in the
ejb-jar.xml file, WebLogic Server uses Supports by default.

� Never: The EJB method does not participate within a transaction context. If
the client calling the method has an active transaction context, WebLogic
Server throws a java.rmi.RemoteException.
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� RequiresNew: WebLogic Server starts and ends a new transaction with each
call to the EJB method. If the caller already has an active transaction,
WebLogic Server suspends it during the method’s invocation.

� NotSupported: The EJB method does not participate within a transaction
context. If the client calling the method has an active transaction context,
WebLogic Server suspends the client transaction during the invocation of the
the method.

� Required: The EJB method requires an active transaction. If the client has an
active transaction context, the EJB method is executed from within that
context. If the client does not have a transaction context, WebLogic Server
starts a new transaction for the invoking the EJB method.

7. In the Methods portion of the edit panel, use the + signs to expand the bean and
interface name(s) that contains the methods you want to configure.

8. Check the selection boxes next to listed methods in the home and remote
interfaces to apply the selected attribute.

9. If you want to apply a different transaction attribute to a different selection of
methods, return to step 3 and create a new collection.

10. Select File->Save to save your changes to the .jar file.

Assigning method permissions

The steps that follow describe how to limit access to individual EJB method calls by
assigning method-level permissions.

Default method permissions in WebLogic Server

If you specify no method-level permissions for an EJB (there is no
method-permission stanza in ejb-jar.xml), WebLogic Server provides “guest”
access to all EJB methods in the .jar file. This ensures that EJB methods have some
default access permission when deployed on WebLogic Server.

If you want to specify method-level permissions you must do so for all methods in all
EJBs stored in the .jar file. If you specify method permissions for even a single EJB
method, WebLogic Server denies access for any methods that do not have permissions
defined in the ejb-jar file.



Configuring basic EJB properties

BEA WebLogic Server Version 5.1 Enterprise JavaBeans 6-25

Changing method permissions

To change an EJB’s method-level permissions:

1. Start DeployerTool and load the EJB .jar file if you have not already done so.
SeeStarting DeployerTool and Loading a .jar file if you need instructions.

2. If the .jar file does not yet contain an application role, follow the instructions in
Mapping application roles to WebLogic Server principals to create one.

3. Select the + sign next to the .jar file name to display its contents.

4. Select the .jar file’s Method permissions object. If you have already assigned
method permissions for the EJB, each collection of permissions is listed as
“perm-n” where n is the collection number.

If no method permissions are available, click the Add button to create a new
“perm-0” permission. DeployerTool highlights the new permission in red to
indicate that you have not yet assigned an application role to the EJB methods.

Note: If you choose to specify method-level permissions, you must do so for all
methods in all EJBs in the .jar file. Otherwise, WebLogic Server denies
access for methods that have no assigned permissions.

5. Select the + sign next to the Method permissions object to display available
permissions.
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6. Select the permission name you want to view or edit. DeployerTool displays the
current application role assignments in the edit panel:

7. In the Methods portion of the edit panel, use the + signs to expand the bean and
interface name(s) that contains the methods you want to configure.

8. Use the Methods check boxes to select each method to which you want to assign
an application role.

9. Use the Can invoke check boxes to specify which application roles can invoke
the selected methods.

10. Return to step 4 and assign method permissions for all other EJB methods in the
.jar file that must be available to clients.
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Adding, removing, and changing environment entries

To configure an EJB’s environment entries or values, follow these steps:

1. Start DeployerTool and load the EJB .jar file if you have not already done so.
SeeStarting DeployerTool and Loading a .jar file if you need instructions.

2. Select the + sign next to the .jar file name to display its contents.

3. Select the + sign next to the Beans object to display all available EJBs in the .jar
file.

4. Select the + sign next to the EJB name you want to view or modify.

5. Select the Environment entries item to display the environment properties for the
selected EJB. DeployerTool shows the Name, Type, and Value for environment
entries in the edit panel:



6 Deploying EJBs with DeployerTool

6-28 BEA WebLogic Server Version 5.1 Enterprise JavaBeans

6. To edit an existing environment entry, double-click an existing Name, Type, or
Value box. Then type in or select a new entry as described below:

� Name: Type in a new name for the EJB environment entry. This is the name
that a deployed EJB uses to look up the environment value.

� Type: Select a Java primitive type from the drop-down menu. The Java type
must be compatible with the specified environment value.

� Value: Type in a new value for the environment property. The new value
must be compatible with the specified Java primitive type.

7. To add a new environment entry, click the Add button to display the New
environment entry dialog. Specify a new Name, Type, Value, and optional
Description for the entry and click OK:

8. To delete an existing environment entry, click once in the row of the entry you
want to delete, then click the Remove button.

9. Select File->Save to save your changes to the .jar file.
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Configuring WebLogic Server deployment 
properties

WebLogic Server uses deployment properties defined in the weblogic-ejb-jar.xml
file to specify an EJB’s caching, performance, and clustering properties. Use the
following instructions to set or change any of these WebLogic Server-specific
properties.

Setting cache and performance properties

1. Start DeployerTool and load the EJB .jar file if you have not already done so.
SeeStarting DeployerTool and Loading a .jar file if you need instructions.

2. Select the + sign next to the .jar file name to display its contents.

3. Select the + sign next to the Beans object to display all available EJBs in the .jar
file.

4. Select the + sign next to the EJB name you want to view or modify.
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5. Select the Optimizations item to display the caching and performance properties
for the selected EJB. DeployerTool displays the current property values in the
edit panel:

6. Edit the displayed property values as necessary:

� Call by reference: Determines whether or not parameters to EJB methods are
copied (passed by value). See enable-call-by-reference for more information.

� Max beans in free pool (stateless session EJBs only): WebLogic Server
maintains a free pool of stateless session EJBs instances for every bean class.
This optional element defines the maximum number of pooled instances. See
Initializing and using EJB instances in The WebLogic Server EJB Container
for more information.

� Initial beans in free pool (stateless session EJBs only): Specifies the number
of EJB instances that WebLogic Server adds to the free pool on startup.
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� Max beans in cache (stateful EJBs only): Maximum number of instances of
this stateful EJB class that are allowed in memory. See Initializing and using
EJB instances in The WebLogic Server EJB Container for more information.

� Idle timeout seconds (Stateful session EJBs only): After this number has been
reached, inactive stateful EJBs may removed if space is needed in the cache.
See EJB Lifecycle in WebLogic Server in The WebLogic Server EJB
Container for more information.

� Cache strategy (Entity EJBs only): Specifies the cache strategy for entity
EJBs in a WebLogic Server cluster. See Entity EJBs in a cluster for more
information.

� Read timeout seconds (Entity EJBs only): Determines ejbLoad() behavior
for read-only entity EJBs in a WebLogic Server cluster. See Entity EJBs in
a cluster for more information.

� Passivation strategy (Entity EJBs only): Select default to keep EJB instances
in the WebLogic Server cache as long as possible, minimizing passivation.
Select transaction to passivate the EJB instance at the completion of each
transaction.

� Database is shared (Entity EJBs only): Specifies whether or not the EJB’s
data store is shared by other servers or clients outside of WebLogic Server.
See Using db-is-shared to limit calls to ejbLoad().

� Is-modified method (Entity EJBs only): Specifies an EJB method WebLogic
Server calls to determine whether or not the EJB data should be stored at the
successful commit of a transaction. See Using is-modified-method-name to
limit calls to ejbStore().

� Finders call ejbLoad (Entity EJBs only): Select true to have WebLogic
Server load the EJB instance into cache immediately when a reference is
returned by a finder. To enable this feature, your finder must return a valid
enumeration of EJBs. Select false to load EJB instances in accordance with
the EJB 1.1 specification.

� Updates at end of transaction: (Entity EJBs only) determines whether
ejbStore() is called at the end of a committed transaction, or after each
method call. See Using delay-updates-until-end-of-tx to change ejbStore()
behavior.

7. Select File->Save to save your changes to the .jar file.
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Setting clustering properties

1. Start DeployerTool and load the EJB .jar file if you have not already done so.
SeeStarting DeployerTool and Loading a .jar file if you need instructions.

2. Select the + sign next to the .jar file name to display its contents.

3. Select the + sign next to the Beans object to display all available EJBs in the .jar
file.

4. Select the + sign next to the EJB name you want to view or modify.

5. Select the Clustering item to display the clustering properties for the selected
EJB. DeployerTool displays the current property values in the edit panel:

6. Edit the displayed property values as necessary:

� Home call router class: Specifies a custom class to use for routing bean
method calls to WebLogic Servers in a cluster. This class must implement
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weblogic.rmi.extensions.CallRouter(). If specified, an instance of
this class will be called before each method call and be given the opportunity
to choose a server to route to based on the method parameters. It either
returns a server name or null indicating that the current load algorithm
should be used to pick the server.

� Home is clusterable: If checked, the bean is deployed with a cluster-aware
home stub. Calls to the home stub are load-balanced between the servers on
which this bean is deployed, and if a server hosting the bean is unreachable,
the call automatically fails over to an available server. If you check Home is
clusterable, also select one of the Home load algorithm options described
below. See EJBs in WebLogic Server Clusters for more information.

� Home load algorithm: Specifies the algorithm WebLogic Server uses to load
balance EJB lookup requests among WebLogic Servers in a cluster. If no
algorithm is specified, WebLogic Server uses the algorithm specified by the
weblogic.cluster.defaultLoadAlgorithm property in
weblogic.properties. Possible settings include:

� round-robin

� random

� weight-based

DeployerTool displays the following properties only for stateless session EJBs:

� Call router class: Specifies a custom class to use for routing bean method
calls. This class must implement
weblogic.rmi.extensions.CallRouter(). If specified, an instance of
this class is called before each method call and is given the opportunity to
choose a routing server based on the method parameters. The method returns
either a server name or null indicating that the current load algorithm should
be used to pick the server.

� Bean is clusterable: If checked, each call to the EJB stub is load-balanced
between the servers that are hosting the bean. If a call to the bean fails due to
a communication failure, the call fails over to another server hosting the
bean. If you check Bean is clusterable, also select one of the load algorithm
options described above.

� Bean methods are idempotent: Checking this option allows the failover
handler to retry a failed call without knowing whether the call actually
completed on the failed server. Check this option only if the stateless session
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EJB methods are truly idempotent. See Session EJBs in a cluster for more
information.

Mapping EJB references

Mapping application roles to WebLogic Server principals

EJB providers can define application roles for EJBs in the ejb-jar.xml deployment
file. Application roles define required roles for EJBs, but they do not specify the actual
security principal names in the running application server.

DeployerTool enables you to create EJB application roles and map them to actual
WebLogic Server security principal names during the deployment process.

To map WebLogic Server principals to EJB application roles:

1. Start DeployerTool using the instructions in Starting DeployerTool.

2. If you have not yet done so, add one or more server profiles using the instructions
in Setting up DeployerTool servers and preferences.

3. Select the WebLogic Server you want to deploy to by clicking on its name in the
Server category.

4. Load an EJB deployment unit using the instructions in Loading a .jar file.

5. Expand the .jar file by clicking the + sign next to its name.

6. Select the .jar file’s Security item to display available application roles in the .jar
file, and available principal names in the selected WebLogic Server.

If the .jar file does not contain any application roles, click Add and enter a name
for the new role.
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7. Click on the name of the application role to modify. DeployerTool shows which
of the current principal names are members of the role by checking the In role
checkbox:

8. To change membership in the selected application role, check or un-check the In
role boxes for the principals you want to add or remove.

9. To delete a selected application role, click the Remove button.

10. Select File->Save to save your changes to the .jar file.

Mapping EJB references

To map EJB references to actual EJBs:

1. Start DeployerTool using the instructions in Starting DeployerTool.
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2. If you have not yet done so, add one or more server profiles using the instructions
in Setting up DeployerTool servers and preferences.

3. Select the WebLogic Server you want to deploy to by clicking on its name in the
Server category.

4. Load an EJB deployment unit using the instructions in Loading a .jar file.

5. Expand the .jar file by clicking the + sign next to its name.

6. Expand the Beans item to display all available EJBs in the .jar file.

7. Expand the EJB name that contains the references you want to view or modify.

8. Select the EJB’s EJB references item to display available references in the .jar
file.

If the .jar file does not contain any EJB references, click Add to create one.

9. Expand the EJB References object (if it is not already expanded) to view
available references in the .jar file.
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10. Select a listed EJB reference to display its properties in the edit panel:

11. Modify the EJB reference properties as follows:

� EJB Link: This entry defines a link to a specific EJB defined in
ejb-jar.xml, or to an EJB installed in a running server (Installed bean).

� Reference bean type: Specify whether the referenced bean is a session EJB or
entity EJB.

� Home interface class: Enter the expected Java class type of the home
interface for this referenced EJB.

� Remote interface class: Enter the expected Java class type of the remote
interface for this EJB reference.

� Linked bean JNDI name: Specify the JNDI name of the references EJB.

� Description: Enter descriptive text for the EJB reference.
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Mapping resource factory references

1. Start DeployerTool using the instructions in Starting DeployerTool.

2. If you have not yet done so, add one or more server profiles using the instructions
in Setting up DeployerTool servers and preferences.

3. Select the WebLogic Server you want to deploy to by clicking on its name in the
Server category.

4. Load an EJB deployment unit using the instructions in Loading a .jar file.

5. Expand the .jar file by clicking the + sign next to its name.

6. Expand the Beans item to display all available EJBs in the .jar file.

7. Expand the EJB name that contains the resource references you want to view or
modify.

8. Select the EJB’s Resource factory references item to display available resource
references in the .jar file.

If the .jar file does not contain any EJB references, click Add and enter a name
for the new reference.

9. Expand the Resource factory references item to list references in the .jar file.
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10. Select a listed resource factory reference to display its properties in the edit
panel:

11. Modify the resource factory reference properties as follows:

� Resource factory type: Select a resource factory type from the drop-down
list. See New resource factory support for more information on available
types.

� Sign-on responsibility: Select whether the responsibility for signing on to the
resource factory lies with the Container or Application.

� JNDI reference link: Enter the JNDI name of the resource factory available in
the selected WebLogic Server.

� Description: Enter descriptive text for the resource factory.
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Configuring persistence properties for 
entity EJBs

You can use DeployerTool to configure persistence properties for Entity EJBs that
use container-managed persistence. The following sections describe how to configure
properties for EJBs that use WebLogic Server RDBMS-based persistence.

If you use a third-party persistence type, configuration may take place within
DeployerTool or in a separate utility or procedure. In either case, refer to your
persistence type documentation for instructions.

Configuring container-managed fields

To view or modify the container-managed fields defined in your XML deployment
files:

1. Start DeployerTool using the instructions in Starting DeployerTool.

2. Load an EJB deployment unit that uses WebLogic Server RDBMS-based
persistence services.

3. Expand the .jar file by clicking the + sign next to its name.

4. Expand the Beans item to display available EJBs in the .jar file.

5. Expand the EJB name that uses WebLogic Server RDBMS-based persistence.
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6. Select the Persistence object to display the EJB’s persistent fields and primary
key definition:

7. To change the primary key type, select a type from the Primary key type
drop-down menu. You can specify a simple primary key by selecting a simple
Java type. Select a compiled primary key class type to define a compound key.
See Simple and compound primary keys for more information.

8. For simple primary keys, select a Primary key field from the drop-down menu.

9. Select the Container-managed check boxes next to a field name to have
WebLogic Server automatically manage persistence for those fields using
RDBMS-based persistence.

Note: For each field that you designate as Container-managed, define the
mapping of the field to a database column using the instructions in
Configuring WebLogic Server RDBMS-based persistence.
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Configuring WebLogic Server RDBMS-based persistence

DeployerTool enables you to perform the following configuration tasks for beans
that use WebLogic Server RDBMS-based persistence services:

� Specifying the table and connection for RDBMS operations

� Mapping container-managed fields to database columns

� Editing EJB finder method expressions

Specifying the table and connection for RDBMS operations

1. Start DeployerTool using the instructions in Starting DeployerTool.

2. Load an EJB deployment unit that uses WebLogic Server RDBMS-based
persistence services.

3. Expand the .jar file by clicking the + sign next to its name.

4. Expand the Beans item to display available EJBs in the .jar file.

5. Expand the EJB name that uses WebLogic Server RDBMS-based persistence.

6. Expand the Persistence item to list available backing stores.

7. Expand the Backing stores item to display the WebLogic RDBMS Persistence
backing store.

8. Select the WebLogic RDBMS Persistence backing store to display configuration
properties in the edit panel.
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9. Click the Configuration tab in the edit panel to display basic backing store
properties:

10. Edit backing store fields to define the high-level mapping for RDBMS
operations:

� Schema name: If applicable to your datastore, enter the schema name that
stores data for container-managed fields.

� Table name: Enter the RDBMS table name that stores data for the EJB’s
container-managed fields. See Mapping container-managed fields to database
columns for information on assigning fields to individual columns in the
selected table.

� Connection pool name: Enter the JNDI name of the connection pool to use
for accessing the RDBMS.

� Transaction isolation level: Select the transaction isolation level to pass to
the underlying datastore for this EJB. See Transaction isolation level for
more information.



6 Deploying EJBs with DeployerTool

6-44 BEA WebLogic Server Version 5.1 Enterprise JavaBeans

Mapping container-managed fields to database columns

Follow these steps to map individual EJB container-managed fields to columns in a
selected datastore:

1. Follow the instructions in Specifying the table and connection for RDBMS
operations to open the WebLogic RDBMS Persistence backing store.

2. Click the Field-column map tab in the edit panel to display the current mapping
between container-managed fields and database columns:

3. To change the database column used to back a container-managed EJB field,
double click the Table column name and type in the new name.

Note: WebLogic Server does not support using quoted RDBMS keywords in a
column mapping. For example, you cannot map EJB fields to columns named
“create” or “select” if those names are reserved in the underlying datastore.
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Editing EJB finder method expressions

Follow these steps to modify the WebLogic Query Language (WLQL) expressions and
Java expressions used in EJB finder methods:

1. Follow the instructions in Specifying the table and connection for RDBMS
operations to open the WebLogic RDBMS Persistence backing store.

2. Click the Finders tab in the edit panel to display the finder methods available in
your deployment files:
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3. To view or change the expressions used in a particular finder method, double
click the method name to display an Edit finder method dialog:

The Name and Parameter(s) section of the dialog lists all parameters to the
selected finder method along with each parameter’s number designation. In the
example above, the findBigAccounts method has a single parameter of type
double, represented by $0. Additional parameters would be designated by $1,
$2, and so forth.

The Query and Expression(s) section lists the text of the WLQL query for the
finder method. The WLQL query uses number designations ($0 in the example
above) to represent values supplied by the finder method arguments, or values
supplied by embedded Java expressions.

The bottom portion of the dialog lists optional Java expressions that you can
embed within the WLQL query. As with the parameters Name and Parameter(s)
section, each Java expression uses a number designation. In the above example,
adding a new Java expression would yield the number designation “1”, since the
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initial value “0” is used by the method parameter. Within the WLQL, expression,
$0 would represent the method parameter, and $1 would represent the embedded
Java expression.

4. To edit the finder’s WLQL query, simply edit the text in the Query and
Expression(s) section of the dialog. See Using WebLogic Query Language
(WLQL) for complete information about WLQL syntax and conventions.

5. To add an embedded Java expression, click the Add button and follow the
instructions below.

6. To edit an embedded Java expression, double-click a column and edit the value as
appropriate:

� No.: Edit the number designation used to refer to the Java expression in the
WLQL query. If you use a number listed in the Name and Parameter(s), you
“override” the parameter designation in the query.

� Text: Enter the text of the Java expression. See Using Java Expressions in
WLQL for complete instructions and restrictions for using embedded Java in
WLQL.

� Type: Enter the return type of the Java expression. See Using Java
Expressions in WLQL for complete instructions and restrictions for using
embedded Java in WLQL.

7. Click OK or Cancel to save or cancel changes to the finder method.

Validating deployment units

DeployerTool validates EJB deployment units in two ways by:

� automatically checking deployment properties and references to ensure that they
contain appropriate values

� checking EJB home, remote, and implementation classes to ensure that method
signatures are compliant with the EJB 1.1 specification
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Validating deployment properties

When you load a new .jar file or change deployment properties, DeployerTool
automatically checks the properties to ensure that supplied values are valid and
appropriate for the selected server. This includes:

� ensuring that all class files referenced in ejb-jar.xml exist in the .jar file

� ensuring that required deployment properties contain values

� checking environment entry values to ensure that they match their associated
Java types

� connecting to a WebLogic Server profile and ensuring that resource factory
references, EJB references, and security principals map to actual JNDI names
and principals in the server

If DeployerTool finds any errors in the deployment properties that would prevent you
from deploying to the selected server, it lists those errors in the Problems display of
the message panel. DeployerTool also highlights in red the .jar file, EJB, method, or
property category that contains the error.

To address deployment property errors:

1. Start DeployerTool and open the .jar file that contains deployment errors.

2. Click the Problems tab in the messages panel to display the deployment error
messages.

3. Expand the red highlighted objects in the object panel to locate the source of
individual deployment errors. As you select nested objects, the Problems display
changes to show only those deployment errors in the current object or property
listing.

4. Edit the property value as indicated in the error message to correct the problem.
DeployerTool validates your entry immediately after editing, so you can
determine if the problem is resolved.

5. Continue addressing highlighted items in the object panel as necessary. Once you
have addressed all of the deployment errors, the .jar file entry will no longer
appear highlighted, and you can continue compiling or deploying the EJBs.
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Checking for compliance with EJB 1.1

DeployerTool provides a compliance checking option to check compiled EJB classes
for compliance to the EJB 1.1 specification. To check the contents of a deployment
unit for compliance to EJB 1.1:

1. Start DeployerTool and open the .jar file that you want to check for compliance.

2. If you have not done so, address all deployment property errors using the
instructions in Validating deployment properties. You cannot check for
compliance to the EJB 1.1 specification until all deployment properties are valid.

3. Select the name of the .jar file to check in the DeployerTool object panel.

4. Select the Messages tab in the messages panel.

5. Select Tools->Check Compliance to begin the validation process.

DeployerTool displays any noncompliance messages in the message panel.
Individual messages are tagged with a section number, which indicates the
section of the JavaSoft EJB 1.1 specification that describes the requirement.

If you need more information about how to address a noncompliance message,
refer to one of the following sources:

� Required changes for EJB 1.1 compliance in the WebLogic Server EJB
documentation

� The section of the JavaSoft EJB 1.1 specification indicated by the
DeployerTool compliance message

After addressing known compliance errors, recompile your classes, repackage
the EJB .jar file, and use DeployerTool to repeat the compliance check.

http://java.sun.com/products/ejb/index.html
http://java.sun.com/products/ejb/index.html
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Compiling and deploying EJBs

Compiling EJB container classes

For each EJB deployment present in a .jar file, DeployerTool calls the ejbc compiler
to generate container implementation classes. The implementation classes are then
processed through the RMI compiler, which generates a client-side stub and a
server-side skeleton.

When you use DeployerTool to generate container classes, the files are inserted back
into the .jar file. If you want to place the container classes into a different file, use ejbc
from the command line, as described in ejbc.

By default, ejbc uses javac as a compiler. For faster performance, specify a different
compiler (such as Symantec's sj) by setting up ejbc preferences within
DeployerTool. See Setting up DeployerTool servers and preferences for more
information.

To generate container classes for EJBs you have loaded:

1. If you have not done so, address all deployment property errors using the
instructions in Validating deployment properties. You cannot generate container
classes until all deployment properties are valid.

2. Select the name of the .jar file to check in the DeployerTool object panel.

3. Select Tools->Generate container... to begin compiling EJBs in the .jar file.

Deploying .jar files to WebLogic Server

To deploy a .jar file to WebLogic Server:

1. If you have not done so, compile the container classes into the .jar file using the
instructions in Compiling EJB container classes.

2. Select the name of the .jar file to check in the DeployerTool object panel.
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3. Select Tools->Deploy... to deploy the .jar file to the default WebLogic Server. If
you want to use a non-default server, select Tools->Deploy To...->server_name
where server_name is the WebLogic Server profile you want to use.

Note: DeployerTool uses hot deployment, via the deploy command shell utility,
to deploy EJBs. See Deploying EJBs in WebLogic Server for general
information on deploying EJBs. See Deploying EJBs in a running WebLogic
Server (Hot Deployment) for specific information and restrictions regarding
hot deployment.



6 Deploying EJBs with DeployerTool

6-52 BEA WebLogic Server Version 5.1 Enterprise JavaBeans



BEA WebLogic Server Version 5.1 Enterprise JavaBeans 7-1

CHAPTER

7 WebLogic Server EJB 
Reference

Overview

This section provides a complete reference to the utilities and support files supplied
with WebLogic Server EJB. It contains reference information for:

� ejbc (weblogic.ejbc)

� DDConverter (weblogic.ejb.utils.DDConverter)

� deploy (weblogic.deploy)

� XML deployment properties

ejbc

Using the XML deployment descriptors present in the input .jar file, weblogic.ejbc
creates wrapper classes for the corresponding EJB classes. It then runs these through
the RMI compiler, which generates a client-side stub and a server-side skeleton. If you
specify an output .jar file, ejbc inserts these files into the .jar.

By default, ejbc uses javac as a compiler. For faster performance, specify a different
compiler (such as Symantec’s sj) using the -compiler flag.
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Syntax 

$ java weblogic.ejbc [options] <source jar file>

<target directory or jar file>

Note: If you output to a .jar file, the output .jar name must be different from the input
.jar name.

Arguments 

Options 

Argument Description

<source jar
file>

Specifies the .jar file containing the compiled EJB classes,
interfaces, and XML deployment files.

<target
directory or jar
file>

Specifies the destination .jar file or deployment directory in which
ejbc places the output .jar. If you specify an output .jar file, ejbc
places the original EJB classes, interfaces, and XML deployment
files in the .jar, as well as the new container classes that ejbc
generates.

Option Description

-help Prints a list of all options available for the compiler.

-version Prints ejbc version information.

-idl Generates CORBA Interface Definition Language for remote
interfaces.
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Examples

The following example uses the javac compiler against an input .jar file in
c:\weblogic\examples\ejb\basic\containerManaged\build. The output .jar
is placed in c:\weblogic\myserver.

$ java weblogic.ejbc -compiler javac
c:\weblogic\examples\ejb\basic\containerManaged\build\std_ejb_bas
ic_containerManaged.jar
c:\weblogic\myserver\ejb_basic_containerManaged.jar

DDConverter

Given one or more EJB 1.0-compliant text deployment descriptors, DDConverter
generates EJB 1.1-compliant XML descriptor files.

-idlOverwrite Overwrites existing IDL files.

-idlVerbose Displays verbose information while generating IDL.

-idlDirectory <dir> Specifies the directory where ejbc creates IDL files. By default,
ejbc uses the current directory.

-keepgenerated Saves the intermediate Java files generated during compilation.

-compiler <javac> Sets the compiler for ejbc to use.

-normi Passed through to Symantec's sj to stop generation of RMI stubs.
Otherwise sj creates its own RMI stubs, which are unnecessary for
the EJB.

-classpath <path> Sets a CLASSPATH used during compilation. This overrides the
system or shell CLASSPATH.
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Syntax 

$ java weblogic.ejb.utils.DDConverter [options] oldDDFile
[oldDDFile2 ...]

Arguments 

DDConverter takes one or more arguments of oldDDFile. Each oldDDFile specifies
a text file containing an EJB 1.0-compliant deployment descriptor.

DDConverter uses the beanHomeName property of EJBs in the text deployment
descriptor files to define new ejb-name elements in the resultant ejb-jar.xml file.
If you specify more than one oldDDFile, you must ensure that no two EJBs in the
collection of files share the same beanHomeName property.

Options 

Examples

The following example converts two EJB 1.0-compliant WebLogic Server
DeploymentDescriptor.txt files into a collection of EJB 1.1-compliant XML files.
The XML files are created in the META-INF subdirectory:

Option Description

-d targetDir Sets the destination directory for the generated XML
files. This directory must exist before you run
DDConverter.

If you do not specify -d, DDConverter uses the
current directory.
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$ java weblogic.ejb.utils.DDConverter -d META-INF
DeploymentDescriptor.txt DeploymentDescriptor2.txt

deploy

Given an EJB 1.1-compliant .jar file, the deploy utility deploys the .jar’s EJBs into a
running WebLogic Server.

Syntax 

$ java weblogic.deploy [options] [list|deploy|undeploy|update]
password {name} {source}

Arguments 

Argument Description

list Lists all EJB deployment units in the specified
WebLogic Server.

deploy Deploys an EJB .jar to the specified server.

undeploy Removes an existing EJB deployment unit from the
specified server.

update Redeploys an EJB deployment unit in the specified
server.

password Specifies the system password for the WebLogic
Server.
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Options 

Examples

See Deploying EJBs in a running WebLogic Server (Hot Deployment) for examples
of using deploy at the command shell.

{name} Identifies the name of the EJB deployment unit. This
name can be specified at deployment time, either
with the deploy or console utilities.

{source} Specifies the exact location of the EJB .jar file, or the
path to the top level of an EJB deployment directory.

Option Description

-help Prints a list of all options available for the deploy
utility.

-version Prints the version of the utility.

-port <port> Specifies the port number of the WebLogic Server to
use for deploying the .jar. If you do not specify this
option, the deploy utility attempts to connect using
port number 7001.

-host <host> Specifies the host name of the WebLogic Server to
use for deploying the .jar. If you do not specify this
option, the deploy utility attempts to connect using
host name “localhost.”

-debug Prints detailed debugging information during the
deployment process.
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XML deployment properties

This section describes the XML elements used to define WebLogic Server EJB
deployment properties.

Note: The WebLogic Server DeployerTool utility provides a graphical way to set
these elements without having to manually edit and validate XML files.

Manually editing XML deployment files

Basic conventions

If you choose to edit XML elements manually:

� Make sure that you use an ASCII text editor that does not reformat the XML or
insert additional characters that could invalidate the file

� Use the correct case for file and directory names, even if your operating system
ignores the case

� To use the default value for an optional element, you can either omit the entire
element definition or specify a blank value, as in:

<max-beans-in-cache></max-beans-in-cache>

DOCTYPE header information

When editing or creating XML deployment files, it is critical to include the correct
DOCTYPE header for each deployment file. In particular, using an incorrect PUBLIC
element within the DOCTYPE header can result in parser errors that may be difficult to
diagnose. The correct text for the PUBLIC element for each XML deployment file is as
follows:

XML file PUBLIC element string

ejb-jar.xml ‘-//Sun Microsystems, Inc.//DTD Enterprise JavaBeans 1.1//EN’
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For example, the entire DOCTYPE header for a weblogic-ejb-jar.xml file is as
follows:

<!DOCTYPE weblogic-ejb-jar PUBLIC
'-//BEA Systems, Inc.//DTD WebLogic 5.1.0 EJB//EN'
'http://www.beasys.com/j2ee/dtds/weblogic-ejb-jar.dtd'>

XML files with incorrect header information may yield error messages similar to the
following, when used with a utility that parses the XML (such as ejbc or
DeployerTool):

SAXException: This document may not have the identifier ‘identifier_name’

identifier_name generally includes the invalid text from the PUBLIC element.

Document Type Definitions (DTDs) for validation

The contents and arrangement of elements in your XML files must conform to the
Document Type Definition (DTD) for each file you use. WebLogic Server utilities
ignore the DTDs embedded within the DOCTYPE header of XML deployment files, and
instead use the DTD locations that were installed along with the server. However, the
DOCTYPE header information must include a valid URL syntax in order to avoid
parser errors.

The following links provide the public DTD locations for XML deployment files used
with WebLogic Server:

� ejb-jar.dtd contains the DTD for the standard ejb-jar.xml deployment
file, required for all EJBs. This DTD is maintained as part of the JavaSoft EJB
1.1 specification; refer to the JavaSoft specification for information about the
elements used in ejb-jar.dtd.

� weblogic-ejb-jar.dtd contains the DTD used for creating
weblogic-ejb-jar.xml, which defines EJB properties used for deployment to
WebLogic Server. This file is located at
http://www.bea.com/servers/wls510/dtd/weblogic-ejb-jar.dtd

weblogic-ejb-jar.xml ‘-//BEA Systems, Inc.//DTD WebLogic 5.1.0 EJB//EN’

weblogicmp-rdbms
-jar.xml

‘-//BEA Systems, Inc.//DTD WebLogic 5.1.0 EJB RDBMS Persistence//EN’

XML file PUBLIC element string
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� weblogic-rdbms-persistence.dtd contains the DTD that defines
container-managed persistence properties for entity EJBs. This DTD is used to
create the weblogic-rdbms-persistence.xml file for using WebLogic Server
persistence services. Third-party persistence vendors may also create XML
deployment files that conform to this DTD. This file is located at
http://www.bea.com/servers/wls510/dtd/weblogic-rdbms-persistence.dtd

Note: Most browsers do not display the contents of files having the .dtd extension.
To view the DTD file contents in your browser, save the links as text files and
view them with a text editor.

weblogic-ejb-jar.xml Properties

weblogic-ejb-jar.xml defines EJB deployment properties unique to WebLogic
Server. The top level elements in weblogic-ejb-jar.xml are as follows:

� description

� weblogic-version

� weblogic-enterprise-bean

� ejb-name

� caching-descriptor

� persistence-descriptor

� clustering-descriptor

� transaction-descriptor

� reference-descriptor

� enable-call-by-reference

� jndi-name

� security-role-assignment
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Caching properties

caching-descriptor

The caching-descriptor stanza affects the number of EJBs in the WebLogic Server
cache as well as the length of time before EJBs are passivated or pooled. The entire
stanza, as well as each of its elements, is optional. WebLogic Server uses default
values where no elements are defined.

The following is a sample caching-descriptor stanza that shows the caching
elements described in this section:

<caching-descriptor>

<max-beans-in-free-pool>500</max-beans-in-free-pool>

<initial-beans-in-free-pool>50</initial-beans-in-free-pool>

<max-beans-in-cache>1000</max-beans-in-cache>

<idle-timeout-seconds>20</idle-timeout-seconds>

<cache-strategy>Read-Write</cache-strategy>

<read-timeout-seconds>0</read-timeout-seconds>

</caching-descriptor>

max-beans-in-free-pool

Note: This element is valid only for stateless session EJBs.

WebLogic Server maintains a free pool of EJBs for every bean class. This optional
element defines the size of the pool. By default, max-beans-in-free-pool has no
limit; the maximum number of beans in the free pool is limited only by the available
memory. See Initializing and using EJB instances in The WebLogic Server EJB
Container for more information.

initial-beans-in-free-pool

Note: This element is valid only for stateless session EJBs.
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If you specify a value for initial-bean-in-free-pool, WebLogic Server
populates the free pool with the specified number of bean instances at startup.
Populating the free pool in this way improves initial response time for the EJB, since
initial requests for the bean can be satisfied without generating a new instance.

initial-bean-in-free-pool defaults to 0 if the element is not defined.

max-beans-in-cache

Note: This element is valid only for stateful session EJBs and entity EJBs.

This element specifies the maximum number of objects of this class that are allowed
in memory. When max-bean-in-cache is reached, WebLogic Server passivates
some EJBs that have not been recently used by a client. max-beans-in-cache also
affects when EJBs are removed from the WebLogic Server cache, as described in
Removing stateful session EJB instances.

The default value of max-beans-in-cache is 100.

idle-timeout-seconds

idle-timeout-seconds defines the maximum length of time a stateful EJB should
remain in the cache. After this time has elapsed, WebLogic Server may remove the
bean instance if the number of beans in cache approaches the limit of
max-beans-in-cache. See EJB Lifecycle in WebLogic Server for more information.

idle-timeout-seconds defaults to 600 if you do not define the element.

cache-strategy

The cache-strategy element can be one of the following:

� Read-Write

� Read-Only

The default value is Read-Write. See Setting the cache strategy for entity EJBs for
more information.



7 WebLogic Server EJB Reference

7-12 BEA WebLogic Server Version 5.1 Enterprise JavaBeans

read-timeout-seconds

The read-timeout-seconds element specifies the number of seconds between
ejbLoad() calls on a Read-Only entity bean. By default, read-timeout-seconds
is set to 600 seconds. If you set this value to 0, WebLogic Server calls ejbLoad only
when the bean is brought into the cache.

Persistence properties

persistence-descriptor

The persistence-descriptor stanza specifies persistence options for entity EJBs.
The following shows all elements contained in the persistence-descriptor
stanza:

<persistence-descriptor>

<is-modified-method-name>. . .</is-modified-method-name>

<delay-updates-until-end-of-tx>. . .</delay-updates-until-end-of-tx>

<find-by-primary-key-calls-ejbload>. . .</find-by-primary-key-calls-ejbload>

<persistence-type>

<type-identifier>. . .</type-identifier>

<type-version>. . .</type-version>

<type-storage>. . .</type-storage>

</persistence-type>

<db-is-shared>. . .</db-is-shared>

<stateful-session-persistent-store-dir>

. . .

</stateful-session-persistent-store-dir>

<persistence-use>. . .</persistence-use>

</persistence-descriptor>
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is-modified-method-name

is-modified-method-name specifies a method that WebLogic Server calls when the
EJB is stored. The specified method must return a boolean value. If no method is
specified, WebLogic Server always assumes that the EJB has been modified and
always saves it.

Providing a method and setting it as appropriate can improve performance. However,
any errors in the method’s return value can cause data inconsistency problems. See
Using is-modified-method-name to limit calls to ejbStore() for more information.

delay-updates-until-end-of-tx

Set this property to “true” (the default), to update the persistent store of all beans in a
transaction at the completion of the transaction. This generally improves performance
by avoiding unnecessary updates. However, it does not preserve the ordering of
database updates within a database transaction.

If your datastore uses an isolation level of TRANSACTION_READ_UNCOMMITTED, you
may want to allow other database users to view the intermediate results of in-progress
transactions. In this case, set delay-updates-until-end-of-tx to “false” to update
the bean's persistent store at the conclusion of each method invoke. See ejbLoad() and
ejbStore() behavior for entity EJBs for more information.

Note: Setting delay-updates-until-end-of-tx to false does not cause database
updates to be “committed” to the database after each method invoke; they are
only sent to the database. Updates are committed or rolled back in the database
only at the conclusion of the transaction.

find-by-primary-key-calls-ejbload

This property is applicable only to entity EJBs.
find-by-primary-key-calls-ejbload determines whether the bean is loaded
immediately into the cache (followed by invoke of ejbLoad) after a call to
findByPrimaryKey returns a reference to the bean.

If this property is set to “true,” WebLogic Server immediately loads the bean into the
cache if a reference to a bean is returned by findByPrimaryKey. If it is set to “false,”
the bean will not be loaded into the cache until the first invoke of the bean.

The default value of find-by-primary-key-calls-ejbload is “false.”
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persistence-type

A persistence-type defines a persistence service that can be used by an EJB. You
can define multiple persistence-type entries in weblogic-ejb-jar.xml for
testing with multiple persistence services. Only the persistence type defined in
persistence-use (described below) is used during deployment.

persistence-type includes several elements that define the properties of a service:

� type-identifier contains text that identifies the specified persistence type.
For example, WebLogic Server RDBMS persistence uses the identifier,
WebLogic_CMP_RDBMS.

� type-version identifies the version of the specified persistence type.

Note: The specified version must exactly match the RDBMS persistence version for
the WebLogic Server release. Specifying an incorrect version results in the
error:

weblogic.ejb.persistence.PersistenceSetupException: Error
initializing the CMP Persistence Type for your bean: No installed
Persistence Type matches the signature of (identifier
‘Weblogic_CMP_RDBMS’, version ‘version_number’).

� type-storage defines the full path of the file that stores data for this
persistence type. The path must specify the file’s location relative to the top level
of the EJB’s .jar deployment file or deployment directory.

WebLogic Server RDBMS-based persistence generally uses an XML file named
weblogic-cmp-rdbms-jar.xml to store persistence data for a bean. This file is
stored in the META-INF subdirectory of the .jar file.

The following shows an example persistence-type stanza with values appropriate
for WebLogic Server RDBMS persistence:

<persistence-type>

<type-identifier>WebLogic_CMP_RDBMS</type-identifier>

<type-version>5.1.0</type-version>

<type-storage>META-INF\weblogic-cmp-rdbms-jar.xml</type-storage>

</persistence-type>
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db-is-shared

The db-is-shared element applies only to entity beans. When set to “true” (the
default value) WebLogic Server assumes that EJB data could be modified between
transactions and reloads data at the beginning of each transaction. When set to “false”
WebLogic Server assumes that it has exclusive access to the EJB data in the persistent
store. See Using db-is-shared to limit calls to ejbLoad() for more information.

stateful-session-persistent-store-dir

stateful-session-persistent-store-dir specifies the file system directory
where WebLogic Server stores the state of passivated stateful session bean instances.

persistence-use

The persistence-use property is similar to persistence-type, but it defines the
persistence service actually used during deployment. persistence-use uses the
type-identifier and type-version elements defined in a persistence-type to
identify the service.

For example, to actually deploy an EJB using the WebLogic Server RDBMS-based
persistence service defined in persistence-type, the persistence-use stanza would
resemble:

<persistence-use>

<type-identifier>WebLogic_CMP_RDBMS</type-identifier>

<type-version>5.1.0</type-version>

</persistence-use>

Clustering properties

clustering-descriptor

The clustering-descriptor stanza defines the replication properties and behavior
for EJBs deployed in a WebLogic Server cluster. The clustering-descriptor
stanza and each of its elements are optional, and are not applicable to single-server
systems.
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The following shows all elements contained in the clustering-descriptor stanza:

<clustering-descriptor>

<home-is-clusterable>. . .</home-is-clusterable>

<home-load-algorithm>. . .</home-load-algorithm>

<home-call-router-class-name>. . .</home-call-router-class-name>

<stateless-bean-is-clusterable>. . .</stateless-bean-is-clusterable>

<stateless-bean-load-algorithm>. . .</stateless-bean-load-algorithm>

<stateless-bean-call-router-class-name>. . .</stateless-bean-call-router-class-name>

<stateless-bean-methods-are-idempotent>. . .</stateless-bean-methods-are-idempotent>

</clustering-descriptor>

home-is-clusterable

You can set this element to either “true” or “false.” When home-is-clusterable is
true, the EJB can be deployed from multiple WebLogic Servers in a cluster. Calls to
the home stub are load-balanced between the servers on which this bean is deployed,
and if a server hosting the bean is unreachable, the call automatically fails over to
another server hosting the bean.

home-load-algorithm

home-load-algorithm specifies the algorithm to use for load balancing between
replicas of the EJB home. If this property is not defined, WebLogic Server uses the
algorithm specified by the server property,
weblogic.cluster.defaultLoadAlgorithm.

You can define home-load-algorithm as one of the following values:

� round-robin: Load balancing is performed in a sequential fashion among the
servers hosting the bean.

� random: Replicas of the EJB home are deployed randomly among the servers
hosting the bean.
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� weight-based: Replicas of the EJB home are deployed on host servers
according to the servers’ current workload.

home-call-router-class-name

home-call-router-class-name specifies the custom class to use for routing bean
method calls. This class must implement
weblogic.rmi.extensions.CallRouter(). If specified, an instance of this class is
called before each method call. The router class has the opportunity to choose a server
to route to based on the method parameters. The class returns either a server name or
null, which indicates that the current load algorithm should select the server.

stateless-bean-is-clusterable

This property is similar to home-is-clusterable, but it is applicable only to stateless
session EJBs.

stateless-bean-load-algorithm

This property is similar to home-load-algorithm, but it is applicable only to stateless
session EJBs.

stateless-bean-call-router-class-name

This property is similar to home-call-router-class-name, but it is applicable only to
stateless session EJBs.

stateless-bean-methods-are-idempotent

You can set this element to either “true” or “false.” Set
stateless-bean-methods-are-idempotent to true only if the bean is written such
that repeated calls to the same method with the same arguments has exactly the same
effect as a single call. This allows the failover handler to retry a failed call without
knowing whether the call actually completed on the failed server. Setting this property
to “true” makes it possible for the bean stub to automatically recover from any failure
as long as another server hosting the bean can be reached.

Note: This property is applicable only to stateless session EJBs.
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Transaction properties

transaction-descriptor

The transaction-descriptor stanza contains elements that define transaction
behavior in WebLogic Server. Currently, this stanza includes only one element:

<transaction-descriptor>

<trans-timeout-seconds>20</trans-timeout-seconds>

<transaction-descriptor>

trans-timeout-seconds

The trans-timeout-seconds element specifies the maximum duration for the EJB’s
container-initiated transactions. If a transaction lasts longer than
trans-timeout-seconds, WebLogic Server rolls back the transaction.

If you specify no value for trans-timeout-seconds, container-initiated transactions
timeout after five minutes, by default.

EJB references

reference-descriptor

The reference-descriptor stanza maps references in the ejb-jar.xml file to the
JNDI names of actual resource factories and EJBs available in WebLogic Server. The
DeployerTool utility simplifies the process of mapping EJB references. You can use
DeployerTool to connect to a WebLogic Server and assign available resources before
deploying. See Mapping EJB references in Deploying EJBs with DeployerTool for
more information.

The reference-descriptor stanza contains one or more additional stanzas to define
resource factory references and EJB references. The following shows the organization
of these elements:

<reference-descriptor>

<resource-description>

<res-ref-name>. . .</res-ref-name>
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<jndi-name>. . .</jndi-name>

</resource-description>

<ejb-reference-description>

<ejb-ref-name>. . .</ejb-ref-name>

<jndi-name>. . .</jndi-name>

</ejb-reference-description>

</reference-descriptor>

resource-description

The following elements define an individual resource-description:

� res-ref-name specifies a resource reference name. This is the reference that
the EJB provider places within the ejb-jar.xml deployment file.

� jndi-name specifies the JNDI name of an actual resource factory available in
WebLogic Server. This is the value that DeployerTool assigns when you map
resource references using the instructions in Mapping resource factory references

ejb-reference-description

The following elements define an individual ejb-reference-description:

� res-ref-name specifies an EJB reference name. This is the reference that the
EJB provider places within the ejb-jar.xml deployment file.

� jndi-name specifies the JNDI name of an actual EJB available in WebLogic
Server. This is the value that DeployerTool assigns when you map EJB
references using the instructions in Mapping EJB references

Security role assignments

security-role-assignment

The security-role-assignment stanza maps application roles in the ejb-jar.xml
file to the names of security principals available in WebLogic Server. As with EJB and
resource references, the DeployerTool utility simplifies the process of mapping
application roles to principals. You can use DeployerTool to connect to a WebLogic
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Server and assign principal names before deploying. See Mapping application roles to
WebLogic Server principals in Deploying EJBs with DeployerTool for more
information.

security-role-assignment can contain one or more pairs of the following
elements:

� role-name is the application role name that the EJB provider placed in the
ejb-jar.xml deployment file.

� principal-name specifies the name of an actual WebLogic Server principal.
This is the value that DeployerTool assigns when you map EJB references
using the instructions in Mapping application roles to WebLogic Server
principals.

enable-call-by-reference

By default, EJB methods called from within the same server pass arguments by
reference. This increases the performance of method invocation since parameters are
not copied.

If you set enable-call-by-reference to “false,” parameters to EJB methods are
copied (pass by value) in accordance with the EJB 1.1 specification. Pass by value is
always necessary when the EJB is called remotely (not from within the server).

weblogic-cmp-rdbms-jar.xml Properties

weblogic-cmp-rdbms-jar.xml defines deployment properties for a single entity
EJB that uses WebLogic Server RDBMS-based persistence services. See Persistence
Services for more information.

The top-level element of weblogic-cmp-rdbms-jar.xml consists of a
weblogic-enterprise-bean stanza:

<weblogic-enterprise-bean>

<pool-name>finance_pool</pool-name>

<schema-name>FINANCE_APP</schema-name>
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<table-name>ACCOUNT</table-name>

<attribute-map>

<object-link>

<bean-field>accountID</bean-field>

<dbms-column>ACCOUNT_NUMBER</dbms-column>

</object-link>

<object-link>

<bean-field>balance</bean-field>

<dbms-column>BALANCE</dbms-column>

</object-link>

</attribute-map>

<finder-list>

<finder>

<method-name>findBigAccounts</method-name>

<method-params>

<method-param>double</method-param>

</method-params>

<finder-query><![CDATA[(> balance $0)]]></finder-query>

<finder-expression>. . .</finder-expression>

</finder>

</finder-list>

<options>

<transaction-isolation>TRANSACTION_SERIALIZABLE</transaction-isolation>

</options>

</weblogic-enterprise-bean>
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RDBMS definition elements

pool-name

pool-name specifies name of the WebLogic Server connection pool to use for this
EJB’s database connectivity. See Using connection pools for more information.

schema-name

schema-name specifies the schema where the source table is located in the database.
This element is required only if you want to use a schema that is not the default schema
for the user defined in the EJB’s connection pool.

Note: This field is case sensitive, although many SQL implementations ignore case.

table-name

table-name specifies the source table in the database. This element is required in all
cases.

Note: The user defined in the EJB’s connection pool must have read and write
privileges to the specified table, though not necessarily schema modification
privileges. This field is case sensitive, although many SQL implementations
ignore case.

EJB field-mapping elements

attribute-map

The attribute-map stanza links a single field in the EJB instance to a particular
column in the database table. The attribute-map must have exactly one entry for
each field of an EJB that uses WebLogic Server RDBMS-based persistence.

object-link

Each attribute-map entry consists of an object-link stanza, which represents a
link between a column in the database and a field in the EJB instance.

http://homepage.beasys.com/denali/classdocs/API_jdbct3.html#connpools
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bean-field

bean-field specifies the field in the EJB instance that should be populated from the
database. This element is case sensitive and must precisely match the name of the field
in the bean instance.

The field referenced in this tag must also have a cmp-field element defined in the
ejb-jar.xml file for the bean.

dbms-column

dbms-column specifies the database column to which the EJB field is mapped. This
tag is case sensitive, although many databases ignore the case.

Note: WebLogic Server does not support quoted RDBMS keywords as entries to
dbms-column. For example, you cannot create an attribute map for column
names such as “create” or “select” if those names are reserved in the
underlying datastore.

Finder elements

finder-list

The finder-list stanza defines the set of all finders that are generated to locate sets
of beans. See Writing Finders for RDBMS Persistence for more information.

finder-list must contain exactly one entry for each finder method defined in the
home interface, except for findByPrimarykey. If an entry is not provided for
findByPrimaryKey, one is generated at compilation time.

Note: If you do provide an entry for findByPrimaryKey, WebLogic Server uses
that entry without validating it for correctness. In most cases, you should omit
an entry for findByPrimaryKey and accept the default, generated method.

finder

The finder stanza describes a finder method defined in the home interface. The
elements contained in the finder stanza enable WebLogic Server to identify which
method in the home interface is being described, and to perform required database
operations.
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method-name

method-name defines the name of the finder method in the home interface. This tag
must contain the exact name of the method.

method-params

The method-params stanza defines the list of parameters to the finder method being
specified in method-name.

Note: WebLogic Server compares this list against the parameter types for the finder
method in the EJB’s home interface; the order and type for the parameter list
must exactly match the order and type defined in the home interface.

method-param

method-param defines the fully-qualified name for the parameter’s type. The type
name is evaluated into a java.lang.Class object, and the resultant object must
precisely match the respective parameter in the EJB’s finder method.

You can specify primitive parameters using their primitive names (such as “double” or
“int”). If you use a non-primitive data type in a method-param element, you must
specify a fully qualified name. For example, use java.sql.Timestamp rather than
Timestamp. If you do not use a qualified name, ejbc generates an error message when
you compile the deployment unit.

finder-query

finder-query specifies the WebLogic Query Language (WLQL) string that is used
to retrieve values from the database for this finder. See Using WebLogic Query
Language (WLQL) for more information.

Note: Always define the text of the finder-query value using the XML CDATA

attribute. Using CDATA ensures that any special characters in the WLQL string
do not cause errors when the finder is compiled.

finder-expression

finder-expression specifies a Java language expression to use as a variable in the
database query for this finder. See Using Java Expressions in WLQL for more
information.
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Persistence options

options

The options stanza defines optional behavior for EJBs using WebLogic Server
RDBMS-based persistence. WebLogic Server currently supports only one optional
element, transaction-isolation.

transaction-isolation

transaction-isolation specifies the isolation level for all of the EJB’s database
operations. The following are possible values for transaction-isolation:

� TRANSACTION_READ_UNCOMMITTED: The transaction can view uncommitted
updates from other transactions.

� TRANSACTION_READ_COMMITTED: The transaction can view only committed
updates from other transactions.

� TRANSACTION_REPEATABLE_READ: Once the transaction reads a subset of data,
repeated reads of the same data return the same values, even if other transactions
have subsequently modified the data.

� TRANSACTION_SERIALIZABLE: Simultaneously executing this transaction
multiple times has the same effect as executing the transaction multiple times in
a serial fashion.

Refer to your database documentation for more information on the implications and
support for different isolation levels.
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